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Installation and Operations Guide for WorkZone Cloud Edition

This guide provides information and guidance about operating WorkZone - Cloud Edition,
including setup, installation, and upgrade instructions.

What's new

Get started

Register WorkZone apps in Azure

Enroll WorkZone - Cloud Edition in Azure and set up SCIM provisioning

Creating Organizational units for WorkZone Cloud Edition

Add guest users
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What's new

Updated guidelines for configuring automatic provisioning for the enterprise
WorkZone application

For instructions on how to provision the group description from Entra ID to WorkZone, see
4. Configure automatic provisioning for the enterprise application.

2024.5

Updated guidelines for configuring automatic provisioning for the enterprise
WorkZone application

For instructions on how to provision the group description from Entra ID to WorkZone, see
4. Configure automatic provisioning for the enterprise application.

New WorkZone for Office registry key for handling redirection templates

A new HideRedirectionTemplate registry key is available for WorkZone for Office Win-
dows Registry. It defines how WorkZone for Office will handle the redirection templates
when new documents are created from WorkZone Client.

See Registry keys.

ServerScan Directory Watcher Service

The new KMDServerScan Directory Watcher Service is a Windows service that uploads
scanned documents and their metadata to cases in WorkZone.

See Install and configure ServerScan Directory Watcher Service.

New behavior of guest user naming

When you create a guest user based on an e- mail address that is not of your organ-
ization's primary domain, the generated user name of the guest user will be suffixed with
arunning number. This behavior isintroduced to ensure that all users have unique user
names. It is generally recommended that you name your internal users uniquely, also
across subdomains. Read more and see an example in Add guest users.

2024.5
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Updated configuration guidelines for registering the WorkZone app in Azure

For instructions on how to register WorkZone app in Azure, see Register WorkZone apps
in Azure and Create a WorkZone Enterprise application.

If you plan to use WorkZone 365 with Exchange Online, you will need to add API per-
missions to your WorkZone app registration. See Register WorkZone apps in Azure.

New WorkZone for Office registry key for handling redirection templates

A new HideRedirectionTemplate registry key is available for WorkZone for Office Win-
dows Registry. It defines how WorkZone for Office will handle the redirection templates
when new documents are created from WorkZone Client.

See Registry keys.

ServerScan Directory Watcher Service

The new KMD ServerScan Directory Watcher Service is a Windows service that uploads
scanned documents and their metadata to cases in WorkZone.

See Install and configure ServerScan Directory Watcher Service.

New behavior of guest user naming

When you create a guest user based on an e- mail address that is not of your organ-
ization's primary domain, the generated user name of the guest user will be suffixed with
arunning number. This behavior isintroduced to ensure that all users have unique user
names. It is generally recommended that you name your internal users uniquely, also
across subdomains. Read more and see an example in Add guest users.

2024 .4

Updated configuration guidelines for WorkZone 365 add-ins

If your organization will use WorkZone 365 with shared mailboxes on the Microsoft
Exchange Server 2019, you must set custom account to your WorkZone 365 application
pool in the Internet Information Services (11S). See Set custom account in WorkZone 365
application pool.

2024.3
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Updated configuration guidelines for WorkZone 365 add-ins

* To use WorkZone 365 add- ins, you will need to download and adjust relevant
manifest files. See Deploy and configure WorkZone 365.

* Forinstructions on how to install and update WorkZone 365 add- ins, see Deploy
and configure WorkZone 365 and Update existing WorkZone 365 add- ins.

* If your organization will use WorkZone 365 with shared mailboxes on the
Microsoft Exchange Server 2019, you must add an impersonation permission to
your Exchange server first. See Using WorkZone 365 with shared mailboxes
on Exchange Server 2019.

2024.2

SmartPost: Important if you upgrade from 2024.1 to 2024.2

If you upgrade from 2024.1to 2024.2 and use SmartPost, you must cancel running
SmartPost processes and restart them using the Send SmartPost dialog (not from the Pro-
cesses Overview). Thisisto ensure that SmartPost uses the upgraded NgDP dispatcher.

Mass Dispatch: Important if you upgrade from 2024.1 to 2024.2

If you upgrade from 2024.1to 2024.2 and use WorkZone Mass Dispatch, you must com-
plete all mass dispatch processes before you upgrade. Any active mass dispatch processes
will not continue to run after the upgrade.

2024.1

No changesin this release.

2024.0

Add process packages

You can now add customized process packages using in WorkZone Configurator.

Note that existing command line Package Loader tool is not supported in a cloud install-
ation.

See Activate and load process packages.

2023.3
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Thisisthe first version of this guide.
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Configure

Follow the procedures below to configure specific WorkZone modules.

Deploy and configure WorkZone 365

WorkZone 365 extends Microsoft 365 (formerly Office) applications with add- ins for doc-
ument management and collaboration.

There are two types of WorkZone 365 add- ins which require different deployment
approaches:

* Qutlook add-ins (for email and meeting integration)

* Office add- ins (for Word, Excel, and PowerPoint integration)

Prepare the WorkZone 365 add-ins manifest files

Before you start the deployment, you must download and, in some cases, adjust the mani-
fest files for all relevant WorkZone 365 add- ins.

A manifest fileisan XML document that tells Microsoft Office how to load and display the
WorkZone 365 add- in. Each type of WorkZone 365 add- ins (Office, Outlook mail, Outlook
meeting) hasits own manifest file.

If you need multiple WorkZone installations to coexist in the same Office environment,

you must customize the manifest files by using unique GUIDs (to prevent conflicts) and dif-
ferent add- in display names (to help usersidentify which WorkZone 365 version they are
using).

Customize the manifest files
To customize the manifest file, you will need to:

Download the manifest file from the WorkZone server

1 Download the manifest files from your WorkZone server using the following
links (copy and paste the URLs provided below into your browser's address
bar, replacing the [hostname] with your proper host name):

* WorkZone 365 add- in for Outlook: https:// [host-
name] /app/office/webaddins/outlook/mail/MailManifest.xml
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* WorkZone Meeting add- in: https://[host-
name] /ap-

p/office/webaddins/outlook/meeting/MeetingManifest.xml

* WorkZone 365 add- in for Word, Excel, and PowerPoint: https://
[hostname] /app/office/webaddins/office/OfficeManifest.xml

2. Replace the [hostname] with your preferred WorkZone instance. For example:
https://workzone.dk/app/ office/ webaddins/ office/ OfficeManifest.xml.

3. Press Enter. The manifest file will be downloaded to your computer's default
download location.

If needed, update the WorkZone ID (GUID)

If you use multiple instances of WorkZone 365, for example, Outlook on the same
Exchange server, or different versions of WorkZone 365 for Outlook on the same
Exchange server, you must change the WorkZone 365 ID (GUID) in the MailMani-
fest.xml under the <1d> tag. For example:

<Id>7f0fl2le-7dba-428b-b37f-6035270e48b4</Id>

An example of a unique ID (GUID) for production and test instances in the manifest files
could look as follows:

e Manifest file for Outlook Test add-in: <I1d>7f0f121e-7dba-428b-b37f-
6035270e48b4</Id>

e Manifest file for Outlook PROD add- in: <Id>d9%be36bl-6aea-425c-87bc-
ce6ld4dce8053d</Id>

You can use a GUID generation tool, for example, GUID Generator to get the unique IDs.

If needed, update the add- in display name and localized label values

By default, the WorkZone 365 add- in label is " WorkZone" , but you can adjust it in the rel-
evant manifest file. If you use multiple instances of WorkZone 365, you will need to
update the label values and DisplayName in the manifest file to identify your envir-
onment in the Office Ul. For example, you can replace "WorkZone" with your envir-
onment name, such as " WorkZone Prod" or " WorkZone Test" . Additionally, you can add a
localized label for different languages (replace the " New_name" in the examples below

10
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with your preferred name for each language).

Examples for each type of manifest files:

* OfficeManifest.xml file (WorkZone 365 add- in for Word, Excel, and PowerPoint):

Example:

<DisplayName DefaultValue="WorkZone">
<Override Locale="da-DK" Value="New name"/>
<Override Locale="de-DE" Value="New Name"/>

</DisplayName>

<Resources>

<bt:ShortStrings>
<bt:String 1d="XXXX.Label" <DefaultValue="WorkZone">
<bt:Override Locale="da-DK" Value="New name" />
<bt:Override Locale="de-DE" Value="New name" />
</bt:String>
</bt:String 1d="YYYY.Label" DefaultValue="WorkZone">
<bt:Override Locale="da-DK" Value="New name" />
<bt:Override Locale="de-DE" Value="New name" />
</bt:String 1d="YYYY.Label" DefaultValue="WorkZone">

<bt:ShortStrings>
* MailManifest.xml file (WorkZone 365 add- in for Outlook):
Example:
<DisplayName DefaultValue="WorkZone">
<Override Locale="da-DK" Value="New name"/>

<Override Locale="de-DE" Value="New name"/>

</DisplayName>
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<Description DefaultValue="WorkZone 365 - Mail">

</Description>

<Resources>

<bt:ShortStrings>
<bt:String i1d="XXXX.Label" <DefaultValue="WorkZone">
<bt:Override Locale="da-DK" Value="New name" />
<bt:Override Locale="de-DE" Value="New name" />
</bt:String>

<bt:ShortStrings>

* MeetingManifest.xml file (WorkZone Meeting add- in for Outlook):

Example:
<Override Locale="da-DK" Value="New name"/>
<Override Locale="de-DE" Value="New name"/>
</DisplayName>

<Description DefaultValue="WorkZone 365 - Meeting">
</Description>

</DisplayName>

Important: Make sure to update all " WorkZone" instances in the XML file.

Save the customized manifest file

Save a copy of each manifest file locally or on a shared drive under a proper file name.
This will help you monitor all your instances and versions of WorkZone 365, especially if
you have updated the displayed name or made any feature changes to the manifest file.
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When you upload the new manifest file, remember to insert the manifest name, descrip-
tion, and GUID for the add- in that you want to update.

After you have adjusted the manifest file(s), you are ready to deploy the WorkZone 365
add- ins.

Deploy the WorkZone 365 add-ins

The deployment approach depends on your environment.

e For Cloud environments: Microsoft 365 Admin Center deployment

* For on- premises environments:

° OQutlook add- ins: Exchange Admin Center deployment

° Office add- ins: Group Policy deployment

Cloud Deployment

1 Open the Microsoft 365 Admin Center.

2. Navigate to Integrated apps > Upload custom apps.

3. Upload your customized manifest files.

For the detailed steps, see Microsoft article Deploy an Office add- in using the admin cen-

ter.

On- Premises Deployment

Outlook add-ins

1 Open the Exchange admin center: https://[exchange- server]/ecp.
2. Upload your customized manifest files (MailManifest.xml and/or Meet-
ingManifest.xml).

3. Install the WorkZone 365 Outlook add- ins. See Microsoft article Add- ins for
Outlook in Exchange Online for the detailed steps.

Office add- ins


https://admin.microsoft.com/
https://docs.microsoft.com/en-us/office365/admin/manage/manage-deployment-of-add-ins?view=o365-worldwide#deploy-an-office-add-in-using-the-admin-center
https://docs.microsoft.com/en-us/office365/admin/manage/manage-deployment-of-add-ins?view=o365-worldwide#deploy-an-office-add-in-using-the-admin-center
https://learn.microsoft.com/en-us/exchange/clients-and-mobile-in-exchange-online/add-ins-for-outlook/add-ins-for-outlook
https://learn.microsoft.com/en-us/exchange/clients-and-mobile-in-exchange-online/add-ins-for-outlook/add-ins-for-outlook
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Office add- ins (for Word, Excel, and PowerPoint) cannot be deployed via Exchange admin
center. Instead, the centralized deployment must be done using the group policies.

1. Download and install Microsoft Office Administrative Templates.

2. On your drive, create a folder named Manifest and add there your OfficeMani-
fest.xml file.

3. Create anetwork share for the Manifest folder, and add network share to trus-
ted locations. See Microsoft article Sideload Office Add-ins for testing from a
network share for the detailed steps.

4. Configure the Group policy for WorkZone 365 add- ins.

Post- deployment verification

After you have deployed the WorkZone 365 add- ins:

* Check that the add- in appears with the Office label specified in the manifest file
e Verify that add- in loads in all required applications

e Confirm that WorkZone functionality works as expected
Troubleshooting

If WorkZone 365 add- ins do not appear:

* Verify that relevant manifest file is available and has correct formatting
* Clear the Office cache. See the Clear cache Microsoft article for the detailed steps.

* Users might need to relaunch the Office app for the WorkZone 365 add- in to
appear.

Note: It may take up to 24 hours for a new add- in to appear for all users. It may take
up to 72 hours for add- in updates or settings changesto reflect to the users. For
more information about centralized deployment of web add- ins, see official
Microsoft guide.

14
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Update existing WorkZone 365 add-ins

When you upgrade to a newer version of WorkZone, the WorkZone 365 add- ins will auto-
matically update to the latest release. However, some releases include updates to the mani-
fest filesto enable new Microsoft features, which meansthat if you made any
customizationsto your manifest files (such as GUIDs, add- in displayed name, localized
labels), you will need to preserve them.

* Any changesto the manifest files will be documented in the release notes.

1. Download the new manifest files from the WorkZone server.

2. Preserve your customizations for the manifest files, if any (GUIDs, displayed
name, localized labels).

3. Upload the customized manifest files using your deployment method:
* For Cloud environments: Microsoft 365 Admin Center > Settings >
Integrated apps.

* For on- premises environments: Update all manifest filesin your net-
work share (for Outlook add- ins) and in the Exchange admin center
(for Office add- ins).

Tip: Sometimes, users may not immediately see the add- in after an update. Users
can try right- clicking the panel to manually refresh it after the new add- in update.
You can verify whether the add- in has been updated by checking if it has a higher
build number than before.

Using WorkZone 365 with shared mailboxes on Exchange Server 2019

If your organization wantsto use WorkZone 365 with shared mailboxes on Microsoft
Exchange Server 2019, you must complete the following steps first:

* Add your Exchange server URL in WorkZone Configurator
* Add impersonation permission to your Exchange Server 2019

e Set custom account in WorkZone 365 application pool
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Important: For shared mailboxes, WorkZone 365 functionality is only supported with
Microsoft Exchange Server 2019 and Microsoft Exchange Server Online. If you use
Exchange Server Online, no additional configuration is needed.

Add your Exchange server URL in WorkZone Configurator

Prerequisite: You must have the CONFIGADM access code to edit the external ser-
vices in WorkZone Configurator.

See Add a new external service.

Add impersonation permission to your Exchange Server 2019

Prerequisite: You must have an administrator account for the Exchange admin cen-
ter.

1 Login to your Exchange admin center: https:// [your exchange server-
1/ecp/, replacing the [your_exchange_server] with your Exchange server. For
example, https://workzone/ecp/.

2. Onthe permissionstab, select admin roles and click +.

Exchange admin center 2
recipients user roles  Outlook Web App policies

permissions (] .

16


#Download
https://docs.workzone.kmd.net/2025_0/en-us/Content/WZCnF_AdminGuide/Services/External_services.htm
#Download

KMD

WorkZone WorkZone Cloud Edition 2025.0 Installation and Operations Guide

3. Inthe new Impersonation dialog:

a. Enter the permission name. For example, Impersonation.

b. Add role: Applicationlmpersonation.

mpersonation

*Mame:

Ilmpersomatiom |

Description:

Write scope:

® |DefauH hd
Organizational unit:
Roles:
NAME P
Members:
+ -

Save Cancel

c. Inthe Members section, click + and add your user.

Prerequisite: This user must also:

e Have access to OData.

e Exist in WorkZone and (only for cloud environments)
in the Entra ID directory (under the Sys-
temAccountUsers catalog in the WorkZone 365 server
properties).

* Be amember of the security group that has security
code 1lor higher (for example, ScanJourCaptia 1).
See Entra ID provision and Apply security groups.

17
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4. Click Save.

Set custom account in WorkZone 365 application pool

1 From web server, open the IIS Manager.

2. Onthe left panel, expand your server and select Application Pools.

5 Internet Information Services (IIS) Manager

"4: = 3 » SIORAD! » Application Pools
Fie View Hep
@3 Application Pool
ication Pools
e-id &8 f PP
§j Start Page This page lets you view and manage the list of application pools on the sesver. Application pol
v & Testadmin
Filter: < 50 - (g Show Al | Group by: No Grouping
Sit x T 1 1 T T
e Name Ststus  NETCLAV.. Managed Pipel.. Identity A
0
0
1
1
1
1
1
2
2
[;,:{yygo Stanted w40 Integrated oolld... 1|

3. Right-click the WZO application pool and select Advanced settings.

4. Under Process Model, click ... next to the Identity.

AUV mll”l e

v (General) "
NET CLR Version va0
Enable 32-Bit Applications True
Managed Pipeline Mode ntegrated
Name WZ(
Queue Length 1000
Start Mode OnDemand

v CPU
Limit (percent) 0
Limit Action NoAction
Limit Interval [minutes) 5
Processor Affinity Enabled False
Processor Affinity Mask 4294957295

Processor Affinity Mask (6<-bit ¢ 4294957295
v Process Model

Generate Process Model Event L

AppctionPooldentty

Idle Time-out (minutes) 20

Idle Time-out Action Terminate v
Identity
[identityType, username, password] Configures the application pool to run

as built-in account, i.e. Application Pool Identity [recommended), Network
Service, Local System, Local Service, or as a specific user identity,

oK Cancel
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5. Click Custom account > Set.

6. Enter the user name and password for your service account in Exchange
Server, and click OK.

7. Verify that your new account is created in WorkZone.

Install and configure WorkZone for Office

Prerequisites for WorkZone for Office

* Visual Studio 2010 Tools for Office Runtime (Download from the Microsoft web-
site).

e During the WorkZone installation, you must select the Office Services feature.

Required data and default values

For WorkZone for Office to work correctly, you must verify that the following default val-
ues are present on the server.

* Document types:

° I(Incoming)

° U (Outgoing)

Roles for document types:

° Afsender (Sender)

° Modtager (Recipient)

° Kopimodt. (Copy Recipient)
° Sagspart (Case Party)

Roles for document references:
° Besvarer (Reply To)
* Organizational contact types:

° A (Unit)
° F(Companies (without CVR))


https://www.microsoft.com/en-us/download/details.aspx?id=48217
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° I (Institutions)
° U (Groups)
° K (Municipalities)
Correct these values manually (if needed) by overriding appropriate elementsin the set-

tings.xml file and uploading those to the database. See Configure WorkZone for Office
server .

Cached Exchange Mode for WorkZone for Outlook

To increase performance for WorkZone for Outlook, it isrequired that you set up the user
accounts in Microsoft Outlook to use Cached Exchange Mode. Cached Exchange Mode
provides users with a better experience when connecting to Microsoft Exchange, because a
full copy of the mailbox is stored on the local computer and is asynchronously updated.

In contrast, users might experience slight performance degradation when running in
Online mode (that is, with Cached Exchange Mode turned off).

WorkZone for Office uses the cached mail store to resolve the email threads that an email
is part of. Thisinformation is used to create a document reference when saving an email
from the Sent items folder in Microsoft Outlook that has been sent in reply to another
saved email. In this special case, there is a slight difference in behavior, since this ref-
erence can only be detected when Cached Exchange Mode is turned on.

Turn on/off cached exchange mode

1 Open Outlook.

2. Onthe File tab, click Account Settings.

3. Onthe E- mail tab, select the Exchange Server account, and then click Change.
4

Under Server settings, select the Use Cached Exchange Mode check box to turn
cached Exchanged Mode on.

Add your website to the local intranet zone

1 Inthe Control Panel, select Internet Options.

- Or-

20
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Run the inetcpl.cp command in the command line.

2. Onthe Security tab, select Local intranet and click Sites.
iternet Options ? s

General Privacy Content Connections Programs Advanced

Select a zone to view or change security settings.

Internet WG s | Trusted sites  Restricted sites

Local intranet
. . . . Sites
@ This zone is for all websites that are

found on your intranet.

3. Click Advanced.

4. Inthe Add thiswebsite to the zone field, enter your website domain, and click
Add.

Enable form- based authentication in Microsoft Office 365 apps

If your organization uses OAuth2 for user authentication, you must enable form- based
authentication in Microsoft Office 365 apps.

To help provide additional security coverage, Microsoft manages how the form- based
authentication in Office applications is handled. Form- based authentication is a legacy
authentication method for Office resources that are not protected by Azure Active Dir-
ectory or a Microsoft account. Because Office does not know the location of the form-
based authentication, Office will block such sign- in dialogs and will notify the end- user
that the sign-in has been blocked.

An administrator can enable the form- based authentication by adding a list of trusted loc-
ations by using a group policy. In this case, your users will be able to open documents from
these locations without the warning.

21
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State Comment

Setting

] Digital Signatures
] Escrow Certificates

] Trust Center

\iz] ActiveX Control Initialization
iiz] Allow file extensions for OLE embedding
Control how Office handles form-based sign-in prompts

Not configured No
Not configured Neo
Not configured No

s Blas £i i | NFN

\iz] Automation S

i) Block addition &= Control how Office handles form-based sign-in prompts (]

2] Check Activ

(2] Check Excel m Control how Office handles form-based sign-in prompts

5] Check OLE o
2) Check owWC d
iz| Disable All Acf
iz] Disable VSTO
i) Disable all Tru
\iz] Disable passw
iz Enable Minim
2] Encrypt docu
\iz] Encryption
(2] Encryption
\iz] Force Runtim

i:) Load Control

iz, Macro Runtin

(L5

\iz] Prevent Word
iz| Protect docun
iiz] Protect docun
iz] Set minimum
\iz] Set password
\iz] Set password
\iz] Set password
\iz] Suppress hyp
iz] Turn off error
iz] Turn off PDF
iz] Use the Sensit]
iz Disable VBA f¢

. Previous Setting Next Setting

O Not Configured Comment: I

(® Enabled
O Disabled

Supported on:

At least Windows Server 2008 R2 or Windows 7

Options:

Help:

Behavior:

Show prompts only from allowed hosts |

Specify hosts allowed to show form-based sign-in
prompts to users:

If you select “Show prompts only from allowed
hosts", you need to enter the hosts by name,
separating the host names with a semi-celeon. For
example:

contoso.com:fabrikam.com

Impertant: You should only include hosts that you
know and trust.

This policy setting controls how Office applications handle
form-based sign-in prompts.

If you enable this policy setting, you must choose one of the
following options:

Block all prompts
Ask the user what to do for each new host
Show prompts only from allowed hosts

If you select “Block all prompts” then no form-based sign-in
prompts are shown to the user and the user is shown a message
that the sign-in method isn't allowed.

If you select “Ask the user what do for each new host” then the
user is asked for each new host whether the user wants to sign-in
to the host. If the user has previously signed-in to a host, 2
form-based sign-in prompt is shown for that host. Also, form-
based sign-in prompts are shown for any hosts specified by the
“Specify hosts allowed to show form-based sign-in prompts to
users” setting.

Cancel Apply

|

End users can unblock themselves by changing a security setting in the Office Trust
Center. They can do so proactively by going to File > Options > Trust Center > Trust Center
Settings > Form- based sign- in, or they can wait until they have been prompted to open
Trust Center via a warning dialog.

In the Trust Center > Form- based Sign- in panel, the end users should change Block all
sign-in promptsto Ask me what to do for each host and save the changes. The list of safe
hosts will be auto- populated based on future end- user actions.

22
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After auser has made this change in the Trust Center, Office will not block future sign-in
prompts. Instead, it will display a dialog asking if the user wants to continue signing in. If
yes, Office will show the sign-in prompt immediately. In the future, Office will provide
sign-in prompts for this allowed host, which will be added to the list of Hosts allowed to
show sign-in promptsin the Trust Center > Form- based Sign- in.

Required registry settings

It isrecommended, that you add the following registry settings on all PCs running
WorkZone for Office, to avoid WorkZone add- in being occasionally turned off in Microsoft
Office applications (Word, Excel, PowerPoint, Outlook).

* General Microsoft Office keys (apply to all Office versions, must be added once)

[HKEY CURRENT USER\SOFTWARE\Microsoft\Internet Explorer-
\Main\FeatureControl\FEATURE_BROWSER_EMULATION]

"OUTLOOK. EXE"=dword:00001b58

[HKEY CURRENT USER\Soft-
ware\Microsoft\Office\Outlook\Addins\Scanjour.Office.OutlookAddIn]

"LoadBehavior"=dword: 00000003

[HKEY_CURRENT_USER\SOft—
ware\Mi-

crosoft\Office\Outlook\Addins\Scanjour.MeetingModule.OutlookAddIn]
"LoadBehavior"=dword: 00000003

[HKEY CURRENT USER\Soft-
ware\Microsoft\Office\Word\Addins\Scanjour.Office.WordAddIn]

"LoadBehavior"=dword: 00000003

[HKEY_CURRENT_USER\SOft—
ware\Microsoft\Office\Excel\Addins\Scanjour.0Office.ExcelAddIn]

"LoadBehavior"=dword:00000003

[HKEY_CURRENT_USER\SOft—
ware\Mi-

crosoft\Office\PowerPoint\Addins\Scanjour.0Office.PowerPointAddIn]

"LoadBehavior"=dword:00000003
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* Microsoft Office 2016, 2019, and Microsoft 365 keys (must be added once):

(e]

o

o

° Qutlook

[HKEY CURRENT USER\Soft-

ware\Mi-

crosoft\Of-

fice\1l6.0\Outlook\Resiliency\DoNotDisableAddinList]

"Scanjour.Office.OutlookAddIn"=dword:00000001

"Scanjour.MeetingModule.OutlookAddIn"=dword: 00000001

The following setting is only required, if you want to view Cases & Docu-
ment lists as a folder in Outlook:

[HKEY CURRENT USER\Soft-

ware\Microsoft\Office\16.0\Outlook\Security]

"EnableRoamingFolderHomepages"=dword: 00000001

See WorkZone for Office user quide for more information.

Word

[HKEY CURRENT USER\Soft-

ware\Mi-

crosoft\Of-

fice\16.0\Word\Resiliency\DoNotDisableAddinList]

"Scanjour.Office.WordAddIn"=dword:00000001

Excel

[HKEY

CURRENT USER\Soft-

ware\Mi-

crosoft\Of-

fice\1l6.0\Excel\Resiliency\DoNotDisableAddinList]

"Scanjour.Office.ExcelAddIn"=dword:00000001

PowerPoint

[HKEY CURRENT USER\Soft-

ware\Mi-
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crosoft\Of-
fice\1l6.0\PowerPoint\Resiliency\DoNotDisableAddinList]

"Scanjour.Office.PowerPointAddIn"=dword:00000001

* Deleting keys (must be rolled out on a daily basis or whenever WorkZone users log
in to their machines):

° Deleting keysto clear blacklists of add- ins that caused Microsoft Office
appsto crash:

[—HKEY_CURRENT_USER\SOft—
ware\Mi-

crosoft\Office\16.0\Outlook\Resiliency\CrashingAddinList]
[—HKEY_CURRENT_USER\SOft—

ware\Mi-

crosoft\Office\16.0\Word\Resiliency\CrashingAddinList]

[-HKEY CURRENT USER\Soft-
ware\Mi-

crosoft\Office\16.0\Excel\Resiliency\CrashingAddinList]

[—HKEY_CURRENT_USER\SOft—

ware\Mi-

crosoft\Of-
fice\1l6.0\PowerPoint\Resiliency\CrashingAddinList]

° Deleting keysto clear the list of already disabled Microsoft Office add- ins:

[—HKEY_CURRENT_USER\SOft—
ware\Microsoft\Office\16.0\Outlook\Resiliency\DisabledItems]

[—HKEY_CURRENT_USER\SOft—
ware\Microsoft\Office\16.0\Word\Resiliency\DisabledItems]

[-HKEY CURRENT USER\Soft-
ware\Microsoft\Office\16.0\Excel\Resiliency\DisabledItems]

[—HKEY_CURRENT_USER\SOft—
ware\Microsoft\Office\16.0\PowerPoint\Resiliency\DisabledItems]

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer-

\ProtocolExecute\wzfo]
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“WarnOnOpen”=dword: 00000000

Configure WorkZone for Office server

You can configure the behavior and appearance of WorkZone for Office by changing the
server settings. For example, you can change the default values by overriding the values in
the server configuration.

Configurable elements

Note: You can also configure many of these elementsin WorkZone Configurator. See
Outlook configuration.

Element Default value Description

Defines the value used for the
record type field on saved
emails.

The value of Incomingisthe
record type field that is used
RecordTypes - Incoming I when saving a received email.
Valid values of Incoming and
Outgoing are values from the
domain on the record type
field (custom domain with the
domain parameter ‘AT’).

Defines the values used for the

record type field on saved

emails.

The value of Outgoingisthe
RecordTypes - Outgoing v record type field that is used
when saving an email which is
sent or going to be sent. Also,

this value is automatically set
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Element Default value

Description

for reply documents. In a stand-
ard configuration, the Docu-
ment Type for reply documents
iISU, Outgoing.

Valid values of Incoming and
Outgoing are values from the
domain on the record type
field (custom domain with
domain parameter ‘AT).

PartyRoleKeys - Sender Afsender

Defines the values used for the
sender, recipient, and Cc recip-
ient roles on archived emails.
Valid values of the Sender,
Recipient, and CcRecipient
roles are values from the
domain on the party:custom
label field in the record
register (custom label with
domain parameter ‘AP’).

PartyRoleKeys - Recipient Modtager

Defines the values used for the
sender, recipient, and Cc recip-
ient roles on archived emails.
Valid values of the Sender,
Recipient, and CcRecipient
roles are values from the
domain on the party:custom
label field in the record
register (custom label with
domain parameter ‘AP’).

PartyRoleKeys - CcRe- )
o Kopimodt
clpient

Defines the values used for the
sender, recipient, and Cc recip-
ient roles on archived emails.
Valid values of the Sender,
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Element Default value

Description

Recipient, and
CcRecipientroles are values
from the domain on the
party:custom label field in
the record register (custom
label with domain parameter
‘AP).

PartyRoleKeys - CaseParty Sagspart

Defines the values used for the
sender, recipient, and Cc recip-
ient roles on archived emails.
Valid values of the Sender,
Recipient, and
CcRecipientroles are values
from the domain on the
party:custom label field in
the record register (custom
label with domain parameter
‘AP’).

DocumentRefRoleKeys -
Besvarer
Reply

Defines the value used for the
role of document references
that is created when replying
to an archived email.

Valid value of Replyisthe value
from the domain on the
appendix:role field in the
record register (custom label
with domain parameter ‘AA’).

ContactTypes - Company A;F;I;U;K

Definesthe list of contact
types which should be con-
sidered as organizational units
during an automatic mapping
of personal sendersto organ-
izational units.
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Element

AutoCreateMissingContact

Default value

True

Description

Defines whether the system
should create contacts from
the email sender, recipient, and
Copy fields if the contacts do
not exist.

SuggestAnyContactWhenSav-

ingEmail

True

Automatically adds or suggests
matching organizational con-
tacts from the contact register
when you save an email from
Outlook. When this setting is
disabled, matching organ-
izational contacts are not
added automatically or sug-
gested to be added.

GlobalSuggestionsBlacklist

gmail.com;
gmail.dk;
hotmail.com;
hotmail.dk;
facebook.com;
yahoo.com;
yahoo.dk;
mail.tele.dk;
mail.tdc.dk

Domain namesin thislist are
excluded from searches for
organizational contacts.

PredefinedFilters

my open_cases;

my personal d rafts

Defines the lists of cases or doc-
umentsto be automatically
added to the navigation pane

in Microsoft Outlook when the
user opens Outlook for the first
time after installing WorkZone
for Outlook.

For example, the following con-
figuration will add the Cases &
Documents folder to the nav-
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Element Default value

Description

igation pane, including two sub-
folders:

* Open Cases (filter
name my open cases)

* Drafts (filter name my

personal drafts)

Find the full list of search fil-
tersin the Standard lists table.

RegisterSelfWhenSaveEmail False

Defines whether the user who
is about to save an Outlook
item appears as a contact in
the Outlookltem Re-
gistrationDialog dialog box.
The default value is False
which meansthat the e- malil
address of the user who saves
an Outlook item does not
appear in the dialog box as a
sender or arecipient. Change
the value to True to make the
email address of the user who
saves the Outlook item appear
as a contact, including sender
or recipient information.

CheckAllUnresolvedContacts False

By default, only contacts from
the To, From, and Cc fields
which are registered in the con-
tact register are selected in the
OutlookltemRegistrationDialog
dialog box. When enabled, all
contacts are automatically
selected.
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Element Default value Description

Defines who should be
assigned as a case handler to
an Outlook item which is about
to be saved on a case. This
value is used for
OutlookltemRegistrationDialog
only.

UseCur-
False

rentUserAsCaseHandler * False— The case hand-
ler isinherited from
the case on which the

Outlook item is saved.

* True — The case hand-
ler that is assigned to
the Outlook item isthe
current user.

Defines if common metadata
values of the multiple saved
Outlook items can be edited.
This value is used for Mul-
tipleSav-
ingCommonMetadataDialog
only.

MassRegistration - _
False * False— Thecommon

EnableEditCommonMetadata metadata values for

the multiple saved
Outlook items cannot
be edited, and the Save
Multiple Outlook Items
dialog box is not dis-
played.

e True — The Save Mul-
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Element Default value

Description

tiple Outlook Items dia-
log box is displayed,
and the common
metadata values for
the multiple saved
Outlook items can be
edited.

DisplayDateFormat SystemDefault

Defines the date format for the
date picker content control.
The configuration of a short or
long date format will apply to
all users, but the exact format
such as dd- mm-yy or MM- dd-
yy will be defined locally by the
user'sregional settings.

If the value is SystemDefault,
the system date format is used.
If the value is Short or Long
the short or long date format is
used respectively.

SuggestAnyContactWhenCreat-

Automatically adds or suggests
matching organizational con-
tacts from the contact register
when you create a case from

. True . . .
ingCase Outlook. When this setting is
disabled, matching organ-
izational contacts are not sug-
gested or added automatically.
, , _ _ Simplifies the search process.
SearchFilters - Register my reading list o _
cases: By specifying search filtersto

Name="Case"

BlackList my meetings;

be excluded from the search
dialog box you can limit the
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WorkZone

Element Default value Description
my organized meet- .
T - number of search options for
ingsy; . .

° case and meeting. Find the full
my_temporary cases; |ist of search filtersin the Avail-
my recent cases; able case and meeting lists
my changed cases table.

Simplifies the search process.
my reading list By specifying search filtersto
SearchFilters — Register records; be excluded from the search

Name="Record"

BlackList

my changed records;
my recent records;

thrashed records

dialog box you can limit the
number of search options for
documents. Find the full list of
search filtersin the Available
document lists table.

Check-
ResolvedContactsBlackList

<empty>

If you do not want the contacts
from a specific company to be
saved as parties, specify the
company's email domain in the
@domain format. When a user
creates a new case or saves an
email to a case in Outlook, con-
tacts that belong to the spe-
cified email domain are not
pre- selected for saving. The
user can select them manually,
if needed.

DocumentTemplatesPath

<empty>

A path to a folder that contains
Word, Excel and Power Point
templates. When a user creates
anew document in WorkZone
Client, this folder opensin the
Windows Open file dialog box.
There are three waysto define
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Element Default value Description
the path:

* Absolute path
* Relative path
e UNCformat
If the path is not defined, the

Office Template selection dia-
log box opens.

<AccessCodesAf-

. . <empty>
fectRequiredFields>

Users assigned access codes lis-
ted here must assign at least
one access code when they cre-
ate a new case, document, or
contact.

Default server settings

Standard value set in WorkZone Office server installer

Below isthe standard value set installed using KMD WorkZone Office Server.msi:

<Scanjour>
<Settings>
<OfficeClients>
<RecordTypes>
<Incoming>I</Incoming>
<Outgoing>U</Outgoing>
</RecordTypes>

<PartyRoleKeys>

<Sender>Afsender</Sender>

<Recipient>Modtager</Recipient>

<CcRecipient>Kopimodt.</CcRecipient>
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<CaseParty>Sagspart</CaseParty>
</PartyRoleKeys>
<DocumentRefRoleKeys>
<Reply>Besvarer</Reply>
</DocumentRefRoleKeys>
<ContactTypes>
<Company>A; F;I;U;K</Company>
</ContactTypes>
<DefaultCountryCode>DK</DefaultCountryCode>

<AutoCreateMiss-

ingContact>True</AutoCreateMissingContact>

<SuggestAnyContactWhenSav-
ingEmail>True</SuggestAnyContactWhenSavingEmail>
<GlobalSuggestionsBlacklist> gmail.-
com; g-—
mail.dk;hot-
mail.-
com; hot-

mail.dk; facebook.com; yahoo.com; yahoo.dk;mail.tele.dk;mail.tdc.dk
</GlobalSuggestionsBlacklist>

<PredefinedFilters>my open cases;my personal draft-

s</PredefinedFilters>

<Register-
SelfWhenSaveEmail>False</RegisterSelfWhenSaveEmail>

<Check-
AllUnresolvedContacts>False</CheckAllUnresolvedContacts>

<UseCur-

rentUserAsCaseHandler>False</UseCurrentUserAsCaseHandler>
<MassRegistration>

<EnableEditCom-
monMetadata>false</EnableEditCommonMetadata>
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</MassRegistration>
<DisplayDateFormat>SystemDefault</DisplayDateFormat>
<SearchFilters>

<Register Name="Case" BlackList="my reading list case-
s;my meetings;my organized meetings;my temporary cases;my recent

cases;my changed cases">
<Filter Name="ClosedCases">

<Description xml:lang="en-GB">Closed case-

s</Description>

<Description xml:lang="da-DK">Afsluttede sager-

</Description>

<Description xml:lang="ja-JP">IRAF ¥ 7 —A</De-

scription>
<Column Name="closed" Value="&lt;&gt; &quot; &quot;" />
</Filter>
</Register>

<Register Name="Record" BlackList="my reading list

records;my changed records;my recent records;thrashed records"/>
</SearchFilters>

<Check-
ResolvedContactsBlackList></CheckResolvedContactsBlackList>

<DocumentTemplatesPath></DocumentTemplatesPath>

<AccessCodesAf-

fectRequiredFields></AccessCodesAffectRequiredFields>
</OfficeClients>
</Settings>

</Scanjour>

How to configure server settings:
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1 Locate the configuration file

$Program Files (x86) \KMD\WorkZone\Mod-

ules\Office\Configuration\settings.xml

2. Edit the setting.xml file and save your changes.

3. Reload the configuration by running the following in the command prompt:

$Program Files (x86) \KMD\WorkZone\Mod-

ules\Office\configurationloader.exe
Use these parameters:
/dbdsn=<dsn>— The name of the database to be updated.
/dbuser=<user>— The name of the database user.
/dbpassword=<password>— The password of the database user.

/serveruri=<protocol>://<hostname>— The protocol and hostname for

the oData service.

/serveruser=<usernameldomain>— The name of a user with accessto
WorkZone.

/serverpassword=<password>— The password of a user with access to
WorkZone.

Registry keys

You can use new registry keysto fine- tune a standard behavior of WorkZone for Office
according to your needs. Below, you can find the right registry path for your configuration:

Computer\HKEY LOCAL MACHINE\SOFTWARE\ScanJour\Clients\Options - Windows
32 bit; Outlook 32 bit or >Windows 64 bit; Outlook 64 bitComputer\HKEY
LOCAL MACHINE\SOFTWARE\WOW6432Node\ScanJour\Clients\Options - Windows 64
bit; Outlook 32 bitComputer\HKEY CURRENT USER\SOFTWARE\ScanJour\Cli-

ents\Options - To apply changes only to the current user's machine

Define a delay to start processing emailsin the Sent folder (the 'Save on Send' func-
tionality)
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1 Addthe SentFolderItemsProcessingDelay key to the registry.

2. Specify the delay in ms.

Skip checking unsaved emails when a user starts WorkZone for Office

1 Addthe IgnoreUnsavedEmailsInSentFolder key to the registry.
2. Specify a value:

e 1- skip checking unsaved emails

* 0 — check the unsaved emails (thisis the default value)

Define how WorkZone for Office will handle the redirection templates when new doc-
uments are created from WorkZone Client

1 Addthe HideRedirectionTemplate key to the registry.

2. Specify a value:

 1- upon detecting aredirection template, WorkZone for Office will
close the document and create a new one from the template selected
by the user.

e 0 — upon detecting aredirection template, WorkZone for Office will
make it invisible instead of closing.

Define atimeout for a SmartTask to be shown in offline mode

The SmartTaskOfflineTimeOut key definesthe time when WorkZone for Office triesto
connect to WorkZone Process. If connection fails during the defined time, smarttask is
shown in the offline mode. When the connection is established again, a user must click
the smarttask to see the updated information.

1 Addthe SmartTaskOfflineTimeOut key to the registry.

2. Specify the timeout in ms.

Define atimeout to disable the Process button
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The StartProcessButtonTimeOut key definesthe time when WorkZone for Office tries
to connect to WorkZone Process. If the timeout has run out and connection wasn't estab-
lished, the Process button stays active and the next attempt to connect will be applied. If
connection fails due to another reason than timeout, the Process button is disabled. Users
see the hint that WorkZone Process is either not installed, or connection has failed.

1 Addthe SstartProcessButtonTimeOut key to the registry.

2. Specify the timeout in ms.

Define source to pull the TLS settings

If you have connection issues related to TLS (Transport Layer Security), it may be caused
by the WorkZone for Office custom settings. To disable them and pull the TLS settings
from the.NET framework, create the DWORD key called SkipCustomTlsSettings in
registry and set its value to 1

Search filters

WorkZone for Office requests search lists from WorkZone. If any of the lists are not
needed on a particular form, WorkZone for Office excludes it by using a specific command
in the request.

Available case and meeting lists (search filters)

User interface name Name in code Description
Open cases my open_cases Your current cases.
. . , Those of your cases
Cases with reminders my case reminders _
that have reminders.
., , Current cases that
Unit’s open cases units open cases _
belong to your unit.
Cases that belong to
- _ units cases without your unit and which are
Unit’s cases with no case handler ,
owner not yet assigned to a

case handler.

Cases with no case handler and cases without owner and Casesthat belongto a
unit unit temporary unit and
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User interface name

Name in code

Description

which are not yet
assigned to a case hand-
ler.

Favorite cases

my favorite cases

Cases that you have
added as favorites.

Followed cases

my followed cases

Cases where you have
subscribed to follow
updates.

Reading list cases

my reading list cases

New cases that have
been assigned to you.

Meetings

my meetings

All your meetings.

Meetings organized by me

my organized meetings

Meetings that you have
organized.

Recent cases

my recent cases

The cases that you have
viewed or edited most
recently. The list dis-
plays up to 1000 cases.

Unclassified cases

my temporary cases

Cases that belong to a
temporary group. You
can assign the casesto
arelevant group at any-
time.

Changed cases

my changed cases

Cases that you follow
which have been
updated recently.

Available document lists (search filters)

User interface name Name in code Description

Those of your documents that
Drafts my personal drafts
- - have the draft or personal
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User interface name

Name in code

Description

draft state.

The documents that you have cre-

Today my documents today

ated today.

All your current documents. This
Documents active documents list does not include any closed or

archived documents.

Favorite documents

my favorite records

Documentsthat you have added
as favorites.

Unit's documents with no
case handler

units documents

without owner

Documentsthat belong to your
unit and which are not yet
assigned to a case handler.

Documents with no case
handler and unit

documents without

owner and unit

Documentsthat belong to atem-
porary unit and which are not yet
assigned to a case handler.

Followed documents

my followed records

Documents where you have sub-
scribed to follow updates.

Scanned today

scanned today

Documentsthat you have scanned
today.

Reading list documents

my reading list

records

New documents that have been
assigned to you.

Recent documents

my recent records

The documents that you have
viewed or edited most recently.
The list displays up to 1000 doc-
uments.

Unanswered documents

my unanswered

records

Those of your documents that
have not been answered by the
reply date.

Changed documents

my changed records

Documentsthat you follow which
have been updated recently.
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User interface name Name in code Description
documents with Documents that you must reply to

Documents with reminders , L
reminders within 7 calendar days.

Troubleshooting

In Edge, while using the WorkZone for Office functionality integrated in WorkZone Client,
you may see the message " Did you mean to switch apps?".

Var det din mening at skifte apps?

“Microsoft Edge” prever at abne "Kmd.Office.UriSchemeHandler”

— ] =]

For example, it can appear when users share documents. The message appears because
Edge encounters an unknown WorkZone handler. To avoid the message, you must add the
following registry settings:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer-

\ProtocolExecute\wzfo]

“WarnOnOpen”=dword: 00000000

While using WorkZone 365 in Internet Explorer, Microsoft Edge, or desktop version, you
click Help, but user guide is not opened.

Workaround: Open the user guide in Chrome.

Solution: Add https://docs.workzone.kmd.net to the local intranet zone:

42



KMD

WorkZone WorkZone Cloud Edition 2025.0 Installation and Operations Guide

1 Click “” Toolsin Internet Explorer and select Internet options.
2. On the Security tab, click Local intranet and then Sites.

Options ? X

General Privacy Content Connections Programs Advanced

Select a zone to view or change security settings.

¢ ¢ v/ O

Internet WG N | Trusted sites  Restricted sites

Local intranet
. . . . Sites
[ﬁ This zone is for all websites that are

found on your intranet.

3. Click Advanced.

4. Typein https://docs.workzone.kmd.net, and click Add.

A meeting was sent to a group, but its contacts are not saved as parties on case.

Sometimes Outlook doesn't parse a group email as a group. In this case, the meeting is
sent, but contacts cannot be extracted by WorkZone. To solve thisissue, ensure that the
group email is converted to the group before sending the meeting. See examples:

Group email converted to the group:

Ta.. Workzone - Team Echo
Subject small review
Location

Group email not converted to the group:

To,. team-echo@company.com
Subject small review
Location

When you save the Process view list, you see the following notice:
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bicrosoft Qutlook Security Motice @

@ Microsoft Office has identified a potential security concern.

This location may be unsafe.

wzfoicreateProcess OwerviewFolder?folderMame=Processer - -
Standardlister - Mine -

Hyperlinks can be harmful fo your computer and data, To protect
wour computer, click only those hyperlink s from trusted sources,

Do wou want to continue?

To fix this, you must add the following registry settings:

Microsoft Office 2016:

[ HKEY_CURRENT_USER\ Soft-
ware\Policies\Microsoft\Office\l6.0\Common\Security\Trusted Pro-

tocols\All Applications\wzfo:]

Note: Value is not mandatory for this key.

In Excel 2016 subscription 365, if you click Cancel for the second time, the Excel document
is closed without the confirmation message.

This is a specific behavior of Microsoft Office 2016, subscription 365.
You see a COMException when the FQDN (fully qualified domain name) host is used

* If you open a previous version of a Microsoft Office document in the File > Cases &
Documents > Manage versions section
- or -

* If you open a non- Microsoft Office document in Outlook overview and the https

protocol is used.

The COMException is caused by a known issue in WebDAV. WebDAYV is used for opening
documents. To fix the exception, proceed with the instructions described in the WorkZone
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Explorer User guide (see Automatic Authentication of users fails when accessing
WorkZone Explorer through an FQDN host).

You may experience a situation when a WorkZone for Office functionality does not work
for no clear reason. Then the reason might be short default timeouts that expire due to
slow network connection.

List of issues that may be caused by short timeouts:

e Smart tasks are in the offline state.
e The Start Process button isdimmed.

* APl methods (for example, opening document, creating a new email and others)

do not work.

* The WorkZone for Office add- in is not ready to process the requests.

To fix these issues, you need to increase the default timeouts:

1 Run regedit.exe.

2. Goto:

HKEY LOCAL MACHINE\SOFTWARE\ScanJour\Clients\Options

3. Set new values for the relevant registry keys.

Registry key Default value (ms) Definition

When a user opens a smart
task, the WorkZone for Office
client should connect to the
WorkZone Process server during

Smart TaskOfflineTimeOut 3000 ) o
the time specified here. If the
time limitation runs out, a noti-
fication with an issue descrip-
tion appears.
WorkZone for Office should con-
StartProcessButtonTimeOut 3000

nect to the WorkZone Process
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server during the time specified
here. If the time limit runs out,
the Start Process button is
dimmed, and a user sees a tool
tip that notifies about the issue.

When ActiveX sends a request
to WorkZone for Office, the
LocalServiceConnectionTimeout 30 000 WCEF service client should con-
nect to the WCF service server
during the time specified here.

When ActiveX sends a request
to, the WorkZone for Office

LocalServiceOperationTimeout 600 000 add- in and the WCF service
should execute the request dur-
ing the time specified here.

When a user launchesthe
o ) WorkZone add- in, the add- in
OpenApplicationTimeout 30 000 .
should get ready during the

time specified here.

Issues in Microsoft Outlook 2016 appeared after installing the October 2017 Microsoft
Outlook security update (patches KB 4011178 and KB 401116 2 respectively).

The security update affects WorkZone for Office case, document and process overview in
Microsoft Outlook. To fix this, you must add the following registry settings:

Microsoft Outlook 2016:

[HKEY CURRENT USER\Software\Microsoft\Office\1l6.0\Outlook\Security]
"EnableRoamingFolderHomepages"=dword:00000001

Find more information here.

Save on Case does not work for appointments and meetings created out of WorkZone for
Office.
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Save on case crashes if the DisableCrossAccountCopy registry setting existsin the
registry list. Find more information here and delete the registry setting if it is worthwhile
for your WorkZone installation.

Install and configure WorkZone SharePoint

Prerequisite:

* WorkZone SharePoint is supported from WorkZone Cloud Edition only.
* Your organization must use Entra ID.

* The WorkZone SharePoint app must be registered in Entra (see Register
WorkZone SharePoint app in Azure).

* WorkZone SharePoint requires WorkZone version 2022.1or later.

WorkZone SharePoint Connector is designed and tested to work on Cloud- based (Azure)
setup with Microsoft Office Online. It isindependent from any other WorkZone service,
although it connects to WorkZone (OData and OAuth2) and Office Online — SharePoint.

The WorkZone SharePoint architecture consists of 3 parts:

1. WorkZone SharePoint Backend (SpConnector) - isresponsible for com-
munication between customer's SharePoint and WorkZone.

2. WorkZone SharePoint Frontend — provides Ul for WorkZone components dis-
played in SharePoint.

3. WorkZone SharePoint package — a SharePoint app to deploy to your SharePoint
site. See Microsoft documentation for detailed guidelines.

WorkZone SharePoint Backend (SpConnector)

Backend can be installed on any server.

Prerequisite:
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* Network connection must be opened for WorkZone OData, WorkZone
OAuth2 and SharePoint Online

e |[ISwebsite named WorkZone hasto be created

* ASP.NET Core Runtime Hosting Bundle in a version .NET 8.0 or later
(delivered with the WorkZone SharePoint Connector) must be installed on
the same server as the WorkZone SharePoint Connector

1 Run the SpConnector.Setup.msi file.

* Default installation path:
C:\Program Files (x86)\KMD\WorkZone\IIS\WorkZone\WZSP
* Configuration file:
C:\Program Files (x86)\KMD\WorkZone\IIS\WorkZone\WZSP\appset-
tings.json

Parameterless installation leaves configuration values empty, although some settings are
required to run the application.

Msi installer accepts the following parameters (case insensitive)

* USE HTTP - default value is false. Enforces HTTPS communication, if true HTTP is
allowed.

* WZ CLIENT ID- ClientlID, registered on local WorkZone OAuth2. Required value.

* WZ CLIENT SECRET - Client secret registered on local WorkZone OAuth2.
Required value.

* WZ ALLOWED URLS - WorkZone server URL (OData).

* SP Client ID- application that is hosting SharePoint in Azure. Required value.

* SP Client Secret - secret that allows connection to SharePoint. Required value.
* SP Tenant ID- Azuretenant where SharePoint is hosted.

* CORS Policy - SharePoint instance URL.
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Example:

msiexec /i "SpConnector.Setup.msi" WZ CLIENT ID=WZSP_ Con-
figClient ID WZ CLIENT SECRET=secret WZ ALLOWED URLS-
S=https://db0l.1lmdom.local SP _Client Id=11b258ae-e076-4fcf-a5cf-
2d6b00134elb SP Client Secret=secret SP Tenant Id=allf8617-45a3-
48a0-a860-2e890el7leal0 CORS Policy=https://kmddk.sharepoint.com/

Additionally, after installing the WorkZone SharePoint, add it to the allowed Cross Origin
Resource Sharing (CORS) origins in OData by editing the

C:\Program Files (x86)\KMD\WorkzZone\IIS\WorkZone\OData\web.config
file on the server with WorkZone. Add the SharePoint instance URL to the existing values
under:

<add key="allowCorsOrigin" wvalue="[SharePoint instance URL]" />

(where "[SharePoint instance URL]" isthe actual URL). See AllowedCorsOrigins parameter
in the Command line configuration for more information about allowing specific origins of
the web client to be accessed.

WorkZone SharePoint Frontend

Frontend does not require any specific hosting. It can be hosted anywhere, but must be
accessible for SharePoint. Frontend contains only static files that have to be put on the
web server. For thisreason, there isno installer provided by KMD.

WorkZone SharePoint package

Package is a SharePoint app that you will need to deploy to your SharePoint Online site, as
described in the Microsoft guidelines.

The workzone. sppkg extention is provided by KMD to each customer/environment sep-
arately, as it containsthe URL to WorkZone services (WorkZone domain, WorkZone
SharePoint Backend and WorkZone SharePoint Frontend).

Upgrade WorkZone SharePoint

If you are upgrading from earlier versions, uninstall the old version of WorkZone
SharePoint before installing the new version.
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Install and configure WorkZone Teams

Prerequisite:

* WorkZone Teams app is currently supported with WorkZone Cloud Edition
only.

* Your organization must use Entra ID.

The installation process consists of three parts:

1 Installing WorkZone Teams on the server.
2. Installing WorkZone Teams on the client.

3. Updating the Cross Origin Resource Sharing (CORS) in OData

Installing WorkZone Teams on the server

WorkZone Teams server- side application is hosted in cloud and deployed by the KMD tech-
nicians.

Installing WorkZone Teams on the client

Prerequisite: You must have the appPackage.zip app manifest (provided by the
KMD technicians).

1 Start Microsoft Teams (either the web version or the desktop version).

2. Upload the WorkZone Teams app. See Upload your custom app in Microsoft
Teams article from Microsoft.

3. Publish the WorkZone Teams app to your organization. See Publish your app to
your org article from Microsoft.
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Updating the Cross Origin Resource Sharing (CORS) in OData

After installing the WorkZone Teams, add it to the allowed Cross Origin Resource Sharing
(CORS) originsin OData by editing the

C:\Program Files (x86)\KMD\WorkZone\IIS\WorkZone\OData\web.config
file on the server with WorkZone. Add the WorkZone Teams URL to the existing values
under:

<add key="allowCorsOrigin" value="[WorkZone Teams URL]" />

(where "[WorkZone Teams_ URL]" isthe actual URL). See AllowedCorsOrigins parameter
in the Command line configuration for more information about allowing specific origins of

the web client to be accessed.

Upgrade WorkZone Teams

If you are upgrading from earlier versions, uninstall the old version of WorkZone Teams
before installing the new version.

Configure WorkZone Explorer

WorkZone Explorer uses WebDAV (Web Document Authoring and Versioning), which is a
standard document protocol over HTTP. WebDAV can run over https as well. With
WorkZone Explorer, you can manage cases and documents from Windows File Explorer.

You can perform common operations on cases and documents such as creating and renam-
ing cases and documents as well as opening, editing, and saving documents directly into
WorkZone from a document editor that supports the WebDAYV protocol, for example,
Microsoft Office or Notepad.

Note: WorkZone Explorer is part of the WorkZone installation. Note that it is not
required to install a client, such as WorkZone Client.

Optimizing performance and user experience

To ensure optimal performance and user experience of WorkZone Explorer, you can apply
specific configurationsto clients and/or to the network/domain.
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LAN Automatically detect settings

If navigating the WorkZone Explorer folders is slow, make sure that the Automatically
detect settings check box in the Local Area Network (LAN) Settings dialog box is cleared on
the client.

To open the Network (KAN) Settings dialog box in Internet Explorer, click Tools > Internet
options > Connections tab > LAN Settings.

Local Area Network (LAN) Settings [

Automatic configuration

Automatic configuration may override manual settings. To ensure the
use of manual settings, disable automatic configuration.

[Miautomatically detect settings:

|:| Use automatic configuration script

Proxy server

[ Use a proxy server for your LAM {These settings will not apply to
dial-up or YPM connections).

80 Advanced

Bypass proxy server for local addresses

Internet security zones

The WebDAV protocol is based on http, can run over https, and Internet Security zones
therefore apply to WorkZone Explorer. To ensure the best user experience and optimal per-
formance, the WorkZone Explorer host name must be configured correctly in the Internet
Security Zones.

1 InInternet Explorer, click Tools > Internet options > Security tab.

2. Add https://webdavhost to either the Trusted sites zone or the Local
intranet zone.
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The Local intranet zone must be selected in order to have automatic integrated
user authentication performed by Windows without Log on dialog boxes.

3. Add file://webdavhost tothe Trusted sites zone.

If the file protocol is added to the Local intranet zone, poor search performance
or display of search results may result when using the search connectors for
searches. In some cases, you might receive a security warning when opening a

document folder location from a search result or when moving documents
from the Recycle Bin to the Restore folder. If you want to avoid these security
prompts, enable Launching applications and unsafe files for Trusted Sites zone.

.

Security Settings - Trusted Sites Zone

Settings

=

) Promgt

|| Endible MIME Sniffing
() Disable
@) Enable

) Disable
@ Enable
| | Launching applications and unsafe files
7) Disable
° EEB
Z) Promgt
|| Launching programs and Files in an IFRAME
_| Disable

) Enable
2 Promplt

Fl (L]}

|| Include local directory path sehen uploading Fies to a server

Blatdmabe windsiie arel Fromar seeeee diffarank Ao zine

*Takes effect after vou reskart your compuber

Reszat cusbom settings

Reset bo: [Mcdum (default) i

Windows 11 File Explorer integration to WorkZone Cloud

If you use Windows 11 and WorkZone Cloud Edition, follow the steps below to enable the

Windows File Explorer integration.
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1. Make sure that you have set Internet Security Zones correctly. See Optimizing
performance and user experience.

2. In Microsoft Edge, go to Settings > Default browser and set:

* The Let Internet Explorer open sites in Microsoft Edge option to Incom-
patible sites only (Recommended),

* The Allow sitesto be reloaded in Internet Explorer mode (IE mode)
option to Allow.

* Under Internet Explorer mode pages, click Add to add the URL of the
WorkZone Explorer page. For example, https://k-
md.workzone.cloud/explorer and https://k-

md.workzone.cloud/explorer/.

You can use a group policy to roll out the Edge setup in an organization.

Advanced features

Permanent links

It is possible to make permanent links to any document or case in the archive. These links
are available through a hidden folder called " .archive" . All you need to know isthe DNS,
the ID, and the file extension, and then you can open any document using following
address:

https://[WorkZoneHost]/.a/WhateverYouWant (D[RecordKey]).[Extension]
This mechanism can also be used to generate permanent links to documents.

You can also show cases through the.archive folder by using:
https://[WorkZoneHost]/.a/WhatEverYouWant (C[FileKey])

View error messages

Sometimes WorkZone Explorer does not show user friendly and descriptive error messages
from the WebDAYV server in case of errors or illegal operations. See FAQ.
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If you want to see the real error from the system, you can use Fddler on the client and, in
this way, see the actual response and error from the server.

Run WorkZone Explorer on a Windows Server

It is not possible to access clients or services directly from the web server.

Tip: For information on how to enable access from the web server, search for " kb
896861" on Microsoft Docs.

If you want to run WorkZone Explorer from Windows File Explorer on a Windows Server
operating system, you must also enable the Windows feature called Desktop Experience.

Troubleshooting

Click an issue below to see the solution or workaround.

Automatic Authentication of users fails when accessing WorkZone Explorer through an
FQDN host

If you access WorkZone Explorer through an FQDN host name, automatic Windows user
authentication will not work. An error message will occur or the Windows Logon window
will be displayed repeatedly.

To make the logon happen automatically, add the https address for the WorkZone
Explorer host to the Windows registry named AuthForwardServerList. For example:
https://db01.1lmdom.local. After you have modified the registry, you have to restart
the WebClient service.

You can find information on how to make this change in the registry in the Microsoft art-
icle Prompt for credentials when you access WebDav- based FODN sites in Windows. Fol-
low the instructions listed under Registry information in the Resolution section.

Note:
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e You do not need to install the hotfix mentioned in the Microsoft article.

* The hotfix mentioned in the Microsoft article is included in Windows 8,
although Windows 8 is not listed in the Properties section.

Users get an error message when they try to create documentsin WorkZone Explorer

If users get an error message when they try to create documentsin WorkZone Explorer, it
is probably because the document type N (Internal) does not exist. WorkZone Explorer
requiresthat the document type N is created and that the DefaultRecordType para-
meter isset to N in the web.config file. Check if this document type has been created in
WorkZone Configurator and in the WorkZone web.config file.

1 In WorkZone Configurator, go to Document > Properties > Document types. If
the document type N does not exist, create it. See Create a property.

2. Check if the parameter DefaultRecordType is set to N under <appsettings>
in the WorkZone web.config file, which islocated in C:\Program Files
(x86) \KMD\Workzone\IIS\Workzone\Explorer. If thisisnot set to N, spe-
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cify it as shown below.

<add
<add
<add
<add
<add
<add
<add
= -<add
<add
<add
<add
<add
<add
<add
<add
<add
<add
<add
<add

key=
key=
key=
key=
key=
key=
key=
key=
key=
key=
key=
key=
key=
key=
key=
key=
key=
key=
key=

Filer Rediger Formater Vis Hjalp

<?xml version="1.8" encoding="utf-8"?>
<configurations

<appSettings>

"DebugLoggingEnabled” value="false"/>
"LogPath” value="~/App_Data/WebDav/Logs"/>

"WorkZoneClientFileLink" value="{@}App/{2}/?frame3=showDetail.asp%3Fregister%3nfile%2:

"WorkZoneClientIcon” value="{@}App/{1}/client/style/themes/favicon.ico"/>

"WorkZoneCaptiaIcon" value="{@}App/Captia/images/sjicon.ico"/>
"workZoneOData" value="{a}opata/"/>
"DefaultFileClass™ value="SJ-TEMP"/>
"DefaultRecordType"” value="N"/>
"AllowPdfRenditionCreation” value="false"/>
"MaxWinTitleLength" value="45"/>
"MaxOtherTitleLength” value="128"/>
"MaxWinPathLength™ value="259"/>

"IncludeFileNo” value="true"/>

"IncludeFilekey” value="false"/>
"MapWin32CreationTimeToLetterDate” value="false"/>
"SetFolderAccessCodeFromParentFolder” value="true"/>
"setFolderFileClassFromParentFolder” value="true"/>
"FlattenFolderHierachy” value="false"/>

"IncludeRecordio” value="false"/> <!-- Possible values: false, pre, post -
</appSettings>

-3

Cannot download more than 50 megabyte or upload large files

WorkZone Explorer is based on Microsoft WebDav to open and edit files (documents) and

isrestricted by any default values defined for the WebDav extension. You can edit the

default values to improve performance when working with large files.

See customize the web client in the registry (external link to Microsoft support) The

information is relevant for the Windows 7 and Windows 10 operating systems.

Configure Citizen Access

WorkZone Citizen Access allows citizens to access their own cases and documents that are

saved in WorkZone. Citizens identify themselves with a digital ID in an external client,

portal, or form and will then get access to specific cases and documents.
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About Citizen Access

Note: Thisisthe first release of WorkZone Citizen Access. The release contains a
basic set of features.

With WorkZone Citizen Access citizens can view the meta data of specific cases and doc-
umentsthat are saved in WorkZone even if the citizens are not registered as WorkZone
users. Citizens must log in with a digital ID in a client, a portal, or a form and will then get
access to view the meta data of specific cases and documents that they have been granted
access to. In thisrelease, it is not possible to view or download documents.

* Portal integration — You can build specific applets or forms as marked cases and
documentsthat allow non WorkZone usersto access " My cases” or "My doc-
uments".

* WorkZone Interact integration — You can create an Interact form that selects
cases and documentsthat are relevant to a citizen's inquiry, for example, a selec-
tion of documents.

As an example, a Danish citizen can access WorkZone data by logging into an Interact
form with MitID (the Danish digital ID). When a citizen logs in with MitID credentials, a
request is redirected to the KMD Identity for authentication and post authentication. The
Interact form getsthe user claims from the KMD Identity and then passes the claimsto
the WorkZone Application Proxy Service to communicate with Identity Data Service to
retrieve the meta data of cases and documents.

Architecture

The diagram below shows the architecture of the Citizen Access module.
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Citizen Access - Reverse Proxy

Client Application
Citizen &i— - - - h[ {e.p.Workzone Interact ]‘—- sesssssenes --—-D[ KIIDMEM‘TI ‘;d.nm ]
Portal) roker

i 1.Icitizenicases
'+ 2-Icitizen/casebyid
3 Jdocuments

--------------------------------

Authentication
MitID authentication

Cititizens in Denmark will log in to a client/form/portal for authentication using MitlID cre-
dentials.

Azure authentication

Azure authentication is used to authenticate the request coming to the OData Service by
using Azure App Client ID and Secret.
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Components
WorkZone Application Proxy Service

WorkZone Application Proxy Service is an endpoint for customers to consume WorkZone
data using WorkZone Identity Service (IDS). This Service exposes the endpoints for other
applications such as Workzone Client Application (Ul for authentication), WorkZone Inter-
act , or any other third- party provider who wants to consume this service to access
WorkZone data.

This service is a containerized service that is deployed in Azure AKS using DevOps
pipelines. Post authentication of citizens, this service is called by providing the end user
claims details with the required payload/input parameters. Also, WorkZone Application
Proxy Service sends a request to Azure APl Gateway.

The endpoints can provide the information that belongs to the citizen such as listing the
cases, case details, and documents associated with the case.

WorkZone Identity Data Service (IDS)

Thisisthe proxy service for OData Service (Containerized). This service is called by Azure
API Gateway to interact with the OData Service by providing the required input para-
meters such as Authentication token, external ID (MitID), and the query parametersto the
OData Service to retrieve the data and will send the response back to WorkZone Applic-
ation Proxy Service.

The WorkZone Identity Service provides:

Restricted access to WorkZone data for external contacts.

* Standard integration to MitID with a later option for other providers.
* Secure access to data via reverse proxy.

* Only access to cases with marked access for contacts.

* Logging of data access via the WorkZone use log.
You can use WorkZone Identity Service in different integrations.
Demilitarized Zone (DM 2):

A DMZ or demilitarized zone is a perimeter network that protects and adds an extra layer
of security to an organization’s internal local- area network from untrusted traffic.
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The main benefit of a DMZ isto provide an internal network with an advanced security
layer by restricting access to sensitive data and servers. A DMZ enables website visitors to
obtain certain services while providing a buffer between them and the organization’s
private network.

WorkZone Application Proxy Service will be deployed in the DMZ with two firewalls. A fire-
wall while accessing the WorkZone Application Proxy Service and a second firewall while
accessing IDS.

Configure Citizen Access

This topic describes how to configure the applications that are required to run WorkZone
Citizen Access.

Prerequisite: To run WorkZone Citizen Access, you must first enable the WorkZone
Citizen Access IDS enabled feature in WorkZone Configurator. Go to Global > Feature
settings > WorkZone Citizen Access.

To run WorkZone Citizen Access, you need the following applications:

Application Deployment Comments

An app that you can use to access the Citizen

Test client Locally Access module. You must configure the app loc-
ally.

WorkZone Applic- .

_ AKS Deploy to AKS as a container.
ation Proxy
APl Management Azure Configure in Azure.
WorkZone Identity ,

AKS Deploy to AKS as a container.

Data Service (IDS)

See also the Architecture diagram.

Prerequisite:

Before you can configure Citizen Access the following prerequisites must be fulfilled:
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* Thetest client application URL must be registered with KMD Identity.
* Valid security detailsto authenticate from KMD ldentity.

* Required access to configure the Azure APl Management service.

* Required accessto Azure Key Vault to read and update the keys.

* Accessto run the PowerShell.

* Accessto Citizen Access repo.

* Accessto Citizen Access Client Application build artifact.

* WorkZone products must be deployed and able to access OData.

* Docker Desktop must be installed locally and must be able to build Linux
images.

Configure the test client

The test client is an app that can be used for testing that citizens can log in with their
digital ID. It's a web application that can be hosted in any Windows- based environment.

Prerequisite:

* .NET 8.0 Runtime installed on the host operating system.
* ASP.NET Core Runtime 8.0 installed on the host operating system.

* Development certificate installed on the host operating system. See the
Microsoft article Generate self- signed certificates with the .NET CLI.

* Unused port number 44375 on localhost (or different one configured with
KMD Identity).
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Fetching the artifacts

1 Get the latest build files from the pipeline [Citizen Access Client App]
(https://dev.azure.com/workzone- kmddk/WorkZone/ _build?defin-
itionld=3147).

Artifact name: ClientBuild

File name: Source.zip
2. Extract filesfrom Source.zip

3. Removethe appsettings.Development.json, and appset-

tings.Production.json files.

Setting up the app

Replace the appsettings.json content with following snippet. The configuration gets
data from WorkZone Citizen Access that is hosted on Dev- AKS.

insert/{
"Logging": {
"LogLevel": {
"Default": "Information",
"Microsoft": "Warning",

"Microsoft.Hosting.Lifetime": "Information"

b
"AllowedHosts": "*",
"Urls": "https://localhost:44375", // url on which application is run-
ning, must be configured with KMD Identity
"Security": {
"IdPMetadataUrl": "https://identity.kmd.dk/adfs/.well-known/openid-
configuration",
"ClientId": "", // ClientId for KMD Identity
"ClientSecret": "", //Client Secret for KMD Identity
"ApiScope": "allatclaims user impersonation",
"RequestDetailsApiUrl": https://<domain>/appproxyservice/api //
Application Proxy API URL
}
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Running the test client

Open shell in folder containing sources and run KMD.Workzone.CA.IdentityClient.exe.

Configure Azure Key Vault

The key value configuration is required to store the keys so that the key will be sent as a
header and validated in IDS.

1 Inthe Azure portal, select Key vaults.

Azure services

+ @ > = © < & NN

plions Container Apps

2. Create anew key vault by choosing a resource group, and fill in information in
the Instance details section.

Home > Keyvaults >

Create a key vault

Project details

Select the subscription to manage deployed resources and costs. Use resource groups like folders to organize and manage all
YOUr resources.

Subscription * PlatformOps-Management-001 e

Resource group ™ ~

Create new

Instance details

Key vault name * (O Enter the name
Region * East US o
Pricing tier* (@ Standard R

3. Click Review + create.
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4. Select the key vault that you just created to create secrets.

[ kmddev-workzone-kv | Secrets

Hame Type Seatus Expiration date
r !
o , gl " Enabiled
oo «" Enabled
®
OCI-INTERCONNECT-SECRET ~ Enabled
X o 1 sohe prot
WA Gy - g s " Engbled
Dbjects

[2 Secrers

5. Select Generate/Import to create a new secret. In this example, create a secret

named IdsKey and enter a secret value, and then click Create.

Home > Keyvaults > kmddev-workzone-kv | Secrets >

B Create a secret

Upload options | Manual
Name * (O | IdsKey
Secret value * (D | ................... .|

Content type (optional) |

Set activation date (@ D

Set expiration date @ D

Enabled [ ves No )
Tags 0 tags
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Create an Azure AKSinstance

1 Inthe Azure portal menu, select Create a resource.

2. In the Search box, enter Kubernetes Services, and then select Kubernetes Ser-
vices.

3. On the Basics tab, fill in the following fields on :

Under Project details:

* Select the subscription.

* Select aresource group in the Resource group field. If the resource
group does not exist, click Create new and enter a resource group name.

Under Cluster details:

* In the Cluster preset configuration field, select Dev/Test for devel-
opment, testing, or demo purposes.

* Enter aname for the Kubernetes cluster
* In the Region field, select aregion for the AKS cluster.
* In the Select Availability zones, select Zone 1, Zone 2 and Zone 3.

* In the AKS pricing tier field, select Free for development, testing, or

66



KMD

WorkZone WorkZone Cloud Edition 2025.0 Installation and Operations Guide

demo purposes.

Create Kubernetes cluster

Project details

Basics Node pools Networking Integrations Monitoring Advanced Tags

Review + create

Select a subscription to manage deployed resources and costs. Use resource groups like folders to organize and manage

all your resources.

Subscription * (O

Resource group * (&

Cluster details

Cluster preset configuration *

Kubernetes cluster name * (O

Region * ()

Availability zones (@)
AKS pricing tier ©
Kubernetes version * (@)
Automatic upgrade (@

Automatic upgrade scheduler

v |
Aks-helm v |
£, Dev/Test v
To quickly customize your Kubernetes cluster, choose one of the preset
configurations above. You can modify these configurations at any time.
Compare presets
aks-cluster |
(Europe) West Europe ~ |
Zones 1, 2 3 - |
Free v |
1.27.7 (default) v ]
Enabled with patch (recommended) W |
2

Every week on Sunday (recommended)
Start on: Mon Feb 12 2024 00:00 (Coordinated Universal Time)

4. On the Node pool tab, click Add new node pool.

5. Enter aname for the node pool and fill in the settings as shown below:
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WorkZone
Add a node pool
Node pool name * (O l linux W
Mode* (O O User
@ System
OsSSKU* (O O Azure Linux
@ Ubuntu Linux
@ Linux is required for system node pools.
Availability zones (0 l Zones 1,23 Lvs
Enable Azure Spot instances (O
o Azure Spot instances cannet be used with system node pools.
Mode size * © ‘ Choose a size
Scale method @ O manual
@ Autoscale - Recommended
@ This option is recommended so that the cluster is automatically sized correctly
for the current running workloads.
Minimum node count* @ L1 N J
Maximum node count* © 3 v
TTTE TTIGATTTRUNTT THALE LUUTIL JITURTEL TUT il ARS LIUGLET 15 TULLIET TIUUE DIURAT giU
5000 nodes across all node pools in this cluster.
Note: Select the 3in the Maximum node count field for for development,
testing, or demo purposes.
6. Click Add.

7. Click Review + create tab.

8. Client Create.

Create a multitenant Microsoft Entra application

You need to create a service principal to get accessto pulling images from WorkZone ACR.

Follow below steps below to configure a service principal in Azure Entra ID.

68




mne WorkZone Cloud Edition 2025.0 Installation and Operations Guide

1 Inthe Azure Portal menu, select Create a resource.

2. In the Search box, enter Microsoft Entra ID, and then select Microsoft Entra ID.
3. Under Manage in the menu, click App registrations > New registration.

4. Enterthe name of the application (the service principal name).

5. Under Supported account types, select Accountsin any organizational directory
(Any Microsoft Entra ID tenant - Multitenant).

6. Under Redirect URI (optional), select Web, and enter any URL. If you have an
authentication endpoint for your organization that you want to use, enter it
here. Otherwise, you can enter https://example.com/auth.

7. Click Register.
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— Microsoft Azure £ Search resources, services, and docs (G+/)

Home > KMD | App registrations >

Register an application

* Name

The user-facing display name for this application (this can be changed later).

MyAKS vy

Supported account types

Who can use this application or access this API?

O Accounts in this organizational directory only (KMD only - Single tenant)
| @ Accounts in any organizational directory (Any Microsoft Entra 1D tenant - Multitenant)

D Agcounts in any organizational directory (Any Microsoft Entra ID tenant - Multitenant) and personal Microsoft accounts (e.g. Skype,
X¥box)

() Personal Microsoft accounts only

Help me choose...

Redirect URI {optional)

We'll return the authentication response to this URI after successfully authenticating the user. Providing this now is optional and it can be
changed later, but a value is required for most authentication scenarios.

[ web v | | https://example.com/auth |

Register an app you're working on here. Integrate gallery apps and other apps from outside your organization by adding from Enterprise applications,

By proceeding, you agree to the Microsoft Platform Polices o

8. Copy the Application (client) ID.
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Home > KMD | App registrations >

i MyAKS =#

|F~ Search | & [i] Delete @ Endpoints [ Preview features

W Overview @ Got a second? We would love your feedback on Microsoft identity platform (previously
& Quickstart

# Integration assistant ~ Essentials

Manage Display name » MyAKS

B Branding & properties |Application (client) 1D : 36528194-caf3-45b7-bi43-b09f7d601793 )
| I

Object ID : 074407ab-1eac-4c3a-9d8b-%a3e3fTeedda
3 Authentication

Directory (tenant) ID : 1e2adb6d6-274f-43e8-8%ef-d36d65bb83b5

Certificates & secrets ! -
Supported account types : Multiple organizations

9. Under Manage in the menu, click Certificates & secrets.

10. Go tothe Client secretstab and click New client secret.

= Microsoft Azure 2 Search resources, services, and docs (G+/)

Home > KMD | App registrations > MyAKS

MyAKS | Certificates & secrets =

[;J Search ] « 27 Got feedback?
B Overview
& Quickstart Credentials enable confidential applications to identify themselves to the authentication servi

scheme). For a higher level of assurance, we recommend using a certificate (instead of a clien
# Integration assistant

Manage
@ Application registration certificates, secrets and federated credentials can be found in the tak
E Branding & properties

3) Authentication

Certificates (0) Client secrets (0)| Federated credentials (0)

Certificates & secrets

. A secret string that the application uses to prove its identity when requesting a token. Also
il Token configuration

< APl permissions -+ New client secret I

& Expose an API Description Expires Value (O

. App roles
Mo client secrets have been created for this application.

11. Enter a description, for example Secret for service principal, and select when the
client secret should expire as per your standards. Click Add.
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Add a client secret X
Description ‘ Secret for service principal |
Expires ‘ Recommended: 180 days (6 months) A |

12. Copy the client secret value by clicking on copy icon. You will need it to update
the AKS cluster's service principal.

Certificates (0) Client secrets (1)  Federated credentials ()
A secret string that the application uses to prove its identity when requesting a token. Also can be referred to as application password.
T MNew client secret
Description Expires Value () Secret 1D
Secret for service principal 81172024 ] j

Note: You cannot copy the secret later.

Provision the service principal in the ACR tenant

Follow the below stepsto provision the service pincipal in ACR tenant. If you do not have
access to provision, you can please send a request to WZ DevOps team by sharing the
APP/Client ID, App (Display) Name, and the redirect URL.

1 Open the following link using an admin account in the ACR tenant. Where indic-
ated, insert the ID of the ACR tenant and the application ID (client ID) of the
multitenant app which was created in Service Principal Configuration.

https://login.microsoftonline.com/<ACR Tenant ID>/oau-
th2/authorize?client id=<Multitenant application ID>&response

type=code&redirect uri=<redirect url>

See Create a multitenant Microsoft Entra application.

2. Inthe Permissions requested window, select the Consent on behalf of your
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organization check, and click Accept.

BT Microsoft

Permissions requested

MyAKS
unverified

This app would like to:

~~ Signin and read user profile

Consent on behalf of your organization

If you accept, this app will get access to the specified resources
for all users in your organization. Mo one else will be prompted to
review these permissions.

Accepting these permissions means that you allow this app to
use your data as specified in their terms of service and privacy
statement. The publisher has not provided links to their terms
for you to review. You can change these permissions at
https://myapps.microsoft.com. Show details

Does this app look suspicious? Report it here

Cancel Accept

Grant the service principal permission to pull from Registry
Follow the below stepsto grant the service principal in the ACRtenant with AcrPull role.
1 Loginintothe Azure Portal.

2. Go to Container Registry, and click Access control (IAM).

3. Click Role assignments, select the service principal, and assign the AcrPull role.

Update AKSwith the Azure Microsoft Entra ID application secret

In the tenant where you created the service principal, run the command to update the AKS
cluster with the service principal credentials:
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az aks update-credentials --resource-group <resource group name> --name
myAKSCluster --reset-service-principal --service-principal "$SP ID" --

client-secret "${SP_SECRET}"

Configure Azure APl Management

Follow the below steps to configure the Azure APl Management.

1. Inthe Azure Portal menu, select Create a resource to create a new resource
group by providing aname and the location.

2. Add administrator rightsto key vault for a specific (logged- in) user.

Home » MotFinalWZCA

pR MNotFinalWZCA | Access control (IAM) = -

- add b Download ol assignments : & Feedback

. Resdew the level of aocess a user, group, sence principal, or managed identiny has 1o this ressurce, Learn i
#l Oneerview

@ Acsiyiog [IE——

"‘\:L Arpcess cantral (LAR)

& Tags Grant access to this resource View access to this resource View deny assignments
. .
o Resource visualizer Grant access ta resources by assigning & roke. View the role assignments that grant access View the rols assignments that have been
Events Leam mare = ta this and other resources. denied access to specific actions at this
o Learn mare = scops.
L=arn mare =
Settings

1

Add role assignment

.
Role Members nditions Review + assign

& role definition is a collection of permissions. You can use the built-in rales or you can create your own custom roles. Learn more of
Job functionroles  Privileged administrator roles

Grant access to Azure resources based on job function, such as the ability to create virtual machines.

P search by role name, description, or 1D Type : All Category : All

-

Mame T Description T4

Key Vault Administrator Perform all data plane operations on a key vault and all cbjects in it. including certificates, keys, and secrets, Cannot mana...
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Add role assignment

Dwscription

3. Go to Key vaults, and create a new key vault with the secret name IdsKey and
the value: <secret value>. The value must be the same as ApiSettings.Key in
IDS.

1 KVWorkZoneWZCA | Secrets

4. Copy files below from the CitizenAccess Repo under the folder Source/ ApiMan-
agement.

* Deploy.psl
* Parameters.json

* Template.json

In the parameters.json file, the names for the API- Management deployment
are predefined. You can change the names if needed.
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The name of Api- Management service must match the parameter while execut-
ing the deploy.pslfile.

5. Execute the Deploy.psilfile to create an API- Management deployment.

a. ./deploy.psl <resource group name> <api-management service

name>

6. When completed, validate it through Postman.

i hitpes fworoone-davaks- ca-apigatTway Lanre- api e tide O0ataRoquost/ cittorne 0 TOPE - 41 A /casen B s

qﬂ

ao@@oo o
i o r F EZF

Configure application proxy

Follow the below steps to configure the Application Proxy Application.

1 Loginto Azure Portal where the service principal is created.

2. Click Show Portal Menu > All resources.

3. Click the Kubernetes services that were created earlier.

4. Click Connect, and copy the commands from the right- side window.

5. Oncethe pod is deployed, update the application proxy url in the client applic-
ation in appSettings.json file.

"RequestDetailsApiUrl": https://<domain>/appproxyservice/api // Application Proxy API URL
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Execute the commands that you just copied in PowerShell in administrative

mode.

Run the command:

kubectl run appproxyservice --image-
=WZCO-
mmon -
weuac-

r.azurecr.io/workzone/wzcitizenaccess/appproxyservice:latest

Configure IDS

Log into Azure Portal where the service principal is created.
Click Show Portal Menu > All resources.
Click the Kubernetes services that were created earlier.

Click Connect, and copy the commands from the right- side window.

77

WorkZone Cloud Edition 2025.0 Installation and Operations Guide




KMD

WorkZone WorkZone Cloud Edition 2025.0 Installation and Operations Guide

»= ChA-Aks-Helm = =

Connect to CA-Aks-Helm

T4 e tomtr
1 g

2 Ron the following comenand:

5. Execute the commandsthat you just copied in PowerShell in administrative

mode.

6. Run thecommand:

kubectl run ids --image-

e=wzcommonweuacr.azurecr.io/workzone/wzcitizenaccess/ids:latest

Helm chart changes

In Power Shell, run the command:

helm upgrade workzone --values values.yaml --set workzone.wzcit-
izenaccess.ids.url=https://wzcitizenaccess-ids/ids --set workzone.wzcit-
izenaccess.appproxy.url=https://wzcitizenaccess-

appproxyservice/appproxyservice --set

workzone.wzcitizenaccess.appproxy.apiGatewayUri=https://<APIM url> --set

workzone.wzcit-
izenaccess.appproxy.openlIdUrl=https://identity.kmd.dk/adfs/.well-

known/openid-configuration

Microsoft Enterprise Mobility Suite (Intune) infrastructure

You can deploy WorkZone Mobile using Microsoft Intune.

78



KMD

WorkZone

WorkZone Cloud Edition 2025.0 Installation and Operations Guide

Requirements

Mobile Device Management Sy

stems

i0S

Android

Microsoft Enterprise Mobility Suite (Intune)

13

The diagram below shows a conceptual overview of the componentsin the infrastructure
and how they are set up to support WorkZone Mobile with Microsoft Enterprise Mobility
Suite (EMS). The number of real servers, firewalls, load balancers, and so on varies depend-

ing on how the environment is set up for a specific organization.

Internet

Azure Cloud

Intune
Mobile Device
Management

Access is authenticated
per device

Intune managed
Mobile device

User not prompted for login

&

On-premises Network

User authentication https

@

With sync’ed users

Azure Application Proxy

Web App/API:
Workzonewebservice

@Avurs Active Directory (AAD)

Mative App:
MobileClientAccess

Unmanaged
Mobile Device

User is promted for login

i

Firey

Azure AD sync
Connector Service

Aplication
Proxy
Connector
Service

On-premises ADFS

Web data |

Internal Domain joined

Server

Some configuration of an organization's infrastructure actions must take place to allow
WorkZone Mobile access to on- premise WorkZone through Microsoft Enterprise Mobility

Suite:
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Syncronization of internal usersto Entra ID

You can do thisin several different ways but to be able to use multifactor authentification,
and thereby also conditional access, the only supported solutionsisto federate your
internal domain using an on- premises ADFS solution. This means that user login requests
are forwarded to an internal ADFS service. Furthermore, it means that there are no pass-
words or password hashes in Azure. Thisis also the only solution that offers users the full
single sign- on experience across internal systems, for example Microsoft Office 365 apps.

Azure Application Proxy with a Proxy Connector service installed

Azure Application Proxy pre- authenticates usersin Entra ID and provides access to under-
lying applications, in this case the internal WorkZone web service. A Proxy Connector ser-
vice isinstalled on an internal server, which isin the same domain as the resources that
are to be exposed, in this case the internal WorkZone web server.

When the Azure Application Proxy service approves a request, it connectsto the internal
Proxy Connector, and requests it to access the internal resource (the WorkZone web
server) on behalf of the current user, and send data back to the user/device on the other
side of the Azure Application Proxy service.

Azure Web App publication of internal WorkZone services

The internal WorkZone web site must be published using Azure Application Proxy as a Web
App/API type, so that it can be accessed externally with the same URL asthe internal cli-
ents use on the domain. Furthermore, it requires that WorkZone is set up to use the
HTTPS.

You set it up so that it isrequired that users are pre- approved with Entra ID before they
get accessto the internal resources. As a second factor, besides user name and password,
you can add a so- called Conditional Access Policy in Azure that only allows access if the
user uses a device, which is managed by Intune. This means that you can use the actual
device as the second factor.

It is also possible to use other built-in two- factor features in Entra ID, for example sms
code or voice call. This will, however, add an extra step to the user's login process.
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Internal WorkZone must run with HTTPS

To publish a web service using Azure Application Proxy, HTTPSis required and as
WorkZone does not support HTTPS off- loading,the underlying WorkZone server must also
use HTTPS.

Flexible management of security

Because you use Entra ID, you also have access to all the options for managing access.
When Microsoft releases new features, you will also be able to use these features to man-
age the access to the WorkZone Mobile app.

Intune deployment of WorkZone Mobile and Microsoft Office 365

To get the full benefit of WorkZone Mobile, it must be deployed along with Office 365,
which offers the possibility to edit Office documents.

Configure WorkZone Mobile in Microsoft Azure Portal

When the requirementsto the infrastructure are fulfilled, you can move on to setting up
and configuring WorkZone Mobile in Microsoft Azure Portal. See Administrator Guide for
WorkZone Mobile.

Deploy WorkZone Integration Platform

The WorkZone Integration Platform is an online tool that you can use to create integ-
rations between WorkZone and external systems. The WorkZone Integration Platform uses
Snaplogic tools for connecting cloud data sources. The WorkZone Integration Platform is
available on the Public and EU- Cloud, however, it is not accessible to customers who oper-
ate in air- gapped environments.

To learn more about SnapLogic and deployment, see Deploying a Groundplex in Kuber-
netesin the SnapLogic documentation.

This page describes how to set up SnaplLogic to integrate with WorkZone and synchronize
data.
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Prerequisites

Before deploying the WorkZone Integration Platform, ensure that your environment
meets the following prerequisites :

* SnaplLogic portal

Ensure accessto the SnaplLogic portal for the EMEA region (Europe, the Middle
East, and Africa). You need an active account and an individual project on the
SnapLogic portal.

Go to https://cdn.emea.snaplogic.com/sl/designer.html# to access the SnaplLogic
portal for the EMEA region.

* SnaplLogicimage

Ensure that the SnapLogic image is available in all the required ACR (Azure Con-
tainer Registry) tenants.

* Memory and CPU per JCC (Java Component Container) node

* Memory: 3Gi

* CPU: 1100m

* Deployment in KMD EU Cloud

If you deploy SnapLogic in KMD EU Cloud, order the following should at KMD Cloud
Center of Excellence (CCoE) for each environment where SnaplLogic will be
installed (SnapLogic should only be installed in production unless otherwise spe-
cified).

Allocate one node of the type DS3_ v2 (2 vCPU, 16 GB RAM).

Note: If you plan to use the SnaplLogic instance towards other environments
outside the AKS cluster where SnaplLogic isinstalled, ensure that the neces-
sary firewall openings are in place.

If you deploy in KMD EU Cloud, order the following at CCoE for each environment
that SnapLogic should be able to communicate with:
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e Source and destination environment/protocol and port: HTTP/HTTPS

80/443 between <company name>.test.workzone.cloud and <insert com-

pany namer>.workzone.cloud

Creating a Snaplex

1 Inthe Snaplogic portal, go to the shared folder, and click + and select Snaplex.

@wuum

5 Q @swraan v

Designar Manager  Dashboard

n Heads up? The: Manager tab will b2 maving seon. To kisp things running smoothly, phease start using the mew Admin Manager from the waffle mene

Customize for Ong
Usars

Groups

Settings

Features

Account Statistics
Snap Packs
Scheduled Tasks

Azset Search

ActratylLog

shared

Al BoCouniy Filgs Tasks Fipelines Snap Packs SnapeE el Tabies Flows

Mama Type Tims
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2. Fllin the required field as shown below.

Update Snaplex ®

Settings Logging NodeProperties NodeProxies Downloads
Mame* | wzsnaplogic

Location  sidekick o

Environment* devaksl

Version | main-28272 - 4.39 GA (Recommended) v

Email addresses for
notifications

Load balancer sezi/7ce

Ultra load balancer ses4/Tcp

oo | [0

Deploy SnaplLogic Groundplex in AKS

1 Inthe Azure portal, open Cloud Shell and create a new directory for SnapLogic.

2. Run the command below to download the Helm charts.

wget https://docs-snaplo-
gic.atlassian.net/wiki/download/attachments/855836057/helm

chart v2.zip?api=v2

3. Unzip the Helm chart:
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unzip helm chart v2.zip\?api\=v2

4. Run the curl command below to get the config link url:

curl -u <userid> https://{controlplane path}/ap-
i/1/rest/public/snaplex/config/{plex path}? {query parameters}

5. Open the SnapLogic Control Plane: elastic.snaplogic.com. To open either the
UAT (User Acceptance Testing) Control Plane or the EMEA Control Plane, sub-
stitute the name for elastic.

UAT Control Plane: uat.snaplogic.com.

EMEA Control Plane: emea.snaplogic.com.

6. Specify the plex path. The syntax for building the SnaplLogic plex path is:
Plex path Format: = /{env org}/{project space}/{project name}/
{snaplex name}

Use the query parameters = Expire_ hours or Version.
For example:

curl -u ftf@kmd.dk https://cd-
n.emea.snaplogic.com/api/1/rest/public/snaplex/config/KMD WZ

DEV/shared/wzsnaplogic?expire hours=336

7. You will be asked to enter password to log in to the SnapLogic portal and get
your specific control_ plane path. Enter the password for the SnaplLogic
account.

8. Theresponse from the above curl command would look something like the
example below, but you only need the config link from the response.
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{"response._map": {"pkes": {"plex-rpm": {"comment": "4.39 GA Linux/RPM", "yrj": "https://snaplogic-prodeu-sldb.s3.eu-
west-1.amazonaws.com:443/pkgs/snaplogic-sidekick-4.main-28272-x86 64.rpm", "driver": null, "signatures": {"md5":
oooocoooooooooooooosxxxxfd 70"}, "pke. file": "snaplogic-sidekick-4.main-28272-x86_64.rpm", "kind": "plex-rpm",
"version": "main-28272", "compatible_version": "main-28272", "status": "active", "create_time":
"2024-11-14T20:10:36.603000+00:00", " _id": "xooooooooooomxxxxxxxxxxxedes"], "plex-deb": {"comment": "4.39 GA
Linux/DEB", "urj": "https://snaplogic- prodeu sldb.s3.eu-west-1.amazonaws.com:443/pkgs/snaplogic-
sidekick- 4ma|n 28272-x86 64.deb”, "driver”: null, "signatures”: {"md5": "x0000000000000000oaaaoa s 742", "pke file":
"snaplogic-sidekick-4.main-28272-x86_64.deb", "kind": "plex-deb", "version": "main-28272", "compatible_version":
"main-28272", "status": "active", "create_ time": "2024-11-14T720:10:44.876000+00:00", " _id":
M000000000000000O0eaaaaae ", "plex-win": {"comment": "4.39 GA Windows/ZIP", "uri": "https://snaplogic-prodeu-
sldb.s3.eu-west-1.amazonaws.com:443/pkgs/snaplogic-sidekick-4.main-28272.zip", "driver": null, "signatures": {"md5":
"ocooeeooononaooeoocenaxxd3561"), "pke file": "snaplogic-sidekick-4.main-28272.zip", "kind": "plex-win", "version":
"main-28272", "compatible version": "main-28272", "status": "active”, "greate time": "2024-11-14T20:10:50.834000+
00:00", " id": "xoccccoccooconxf2095"}), "config":
"https://emea.snaplogic.com/fapi/1/rest/plex/config/<QrganizationName>/<snaplexfolder=/<SnaplogicName>?expires=
17334741788 user_id=ftf%40kmd.dk& sl authproxy key=PAvugDkubyhW{iPCZEHwW0e%2Food%2FtfcxBigZKGZ5Irdfo%
tus. code": 200}

9. Changethe directory to helm_chart_v2 and open the values.yaml file with the
command “vi values.yaml ™.

2

Copy or download the file — Values.yaml| file.

# Default values for snaplogic-snaplex.
# This is a YAML-formatted file.

# Declare variables to be passed into your templates.

# Regular nodes count

jccCount: 1

# Feedmaster nodes count

feedmasterCount: O

# Docker image of SnapLogic snaplex
image:
repository: snaplogic/snaplex

tag: latest

# SnapLogic configuration link

snaplogic config link: https://e-
mea.snaplogic.com/api/1l/rest/plex/config/KMD WZ DEV/shared/wz-
snaplogic?expires=1734330726&user id=ftf%$40kmd.dk& sl
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authproxy key-
y=dFdPVa9My9NoWyYO80yY$2BUDuOZYupAc2C340uOCP%2BJc%3D

# SnapLogic Org admin credential

#snaplogic secret:

# Enhanced encryption secret

#enhanced encrypt secret:

# CPU and memory limits/requests for the nodes
limits:

memory: 3Gi

cpu: 1100m
requests:

memory: 3Gi

cpu: 1100m

# Default file ulimit and process ulimit
sl file ulimit: 8192

sl process ulimit: 4096

# Enable/disable startup, liveness and readiness probes
probes:

enabled: true

# JCC HPA
autoscaling:

enabled: false

minReplicas:

maxReplicas:
# Average count of Snaplex queued pipelines (e.g. tar-

getPlexQueueSize: 5), leave empty to disable

# To enable this metric, Prometheus and Prometheus-Adapter
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are required to install.

targetPlexQueueSize:

# Average CPU utilization (e.g. targetAvgCPUUtilization: 50
means 50%), leave empty to disable.

# To enable this metric, Kubernetes Metrics Server is
required to install.

targetAvgCPUUtilization:

# Average memory utilization (e.g. tar-
getAvgMemoryUtilization: 50 means 50%), leave empty to disable.

# To enable this metric, Kubernetes Metrics Server is
required to install.

targetAvgMemoryUtilization:

# window to consider waiting while scaling up. default is O0s
if empty.

scaleUpStabilizationWindowSeconds:

# window to consider waiting while scaling down. default is
300s if empty.

scaleDownStabilizationWindowSeconds:
# grace period seconds after JCC termination signal before
force shutdown, default is 30s if empty.

terminationGracePeriodSeconds: 900

# Enable IPv6 service for DNS routing to pods
enableIPv6: false

10. Changethe limits and request parameters according to the AKS configuration
and specify the image that is available in the ACR.
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* Set the JCC node count as per the requirements.
* Set the FeedMaster node count to O.

* Delete all the FeedMaster related files from the template.

n » helm_chart v2 > ! wvaluesyam

11. Go back to theroot directory and run the command below to install the Helm

chart:

helm install snaplogic helm chart v2 --namespace workzone - -

set-string snaplogic config link='<paste the config link>'

The deployment is ready:
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Hiomie kmddev-wz-devaks-weu-aks
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The JCC node should be up and running as shown below without any errors and
alerts.

Snaplex Health

osnaplagic—snaplﬂgic—snapl... 08
Cloud Up since 21272024, 2:22:20 pm
) Version 4.39 GA (Recommended)
Total Nodes 1 Heartbeat 2122024, 2:40:00 pm
MNodes Active 1 e
v
) | £
o Local JAK Groundplex 08 o é
Total Nodes 1
Nodes Active 1 CPU%% Memory3e
v
.
1 Resource Histor Alerts
o wzsnaplogic 08 u istory
Total Nodes 1 ’
Modes Active 1 Duration
h

Test the Snaplex JCC node

To test if the deployed Snaplex JCC node works, you can go to the Designer tab and select
any sample pipeline or build a pipeline as per the requirements. Select the required
Snaplex against which you want to run the pipeline and click the Execute/Run button.
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Designer = Manager  Dashbosrd SnapGPT L1 () (g sreeniaskaushic ¥ | KMO_WZ_DEV MIHH
form [ orecocee kRO BeHT0 BLL®
@ + ® Generate invoice S50 x Calculate costs - Bacegn foranstaitning % PipelineintogrationTest”
| -
DD a
i e
Pipeline Execution Statistics: Generate Invoice 550 0 ®
Snap Statistics Pipeline Parameters Extra Details
| Started onMov 29 at 10:55:34 am, completed in 6.89s ® Datafiow order Alphabetical order ;
] [
& 50N Spimer — 0% H0KES - - -

If the pipeline state is green, the deployment was successful and the data is being integ-
rated.

Deploy the SnapLogic Groundplex in EU Cloud

Resource configuration in production: DS3_ v2 (2 vCPU, 16 GB RAM).

Deploy SnaplLogic Groundplex

1 Create Service connection (SPN) to access the resources from Azure.

2. Ensurethat the SnapLogic docker image is available in the kmdworkzone ACR
(kmdworkzone..azurecr.io/snaplogic/snaplex:latest).

3. Addtheimage pull secret to the environment configuration.
Install and configure ServerScan Directory Watcher Service

ServerScan Directory Watcher Service is a Windows service that uploads scanned doc-
uments and their metadata to cases in WorkZone.
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About ServerScan Directory Watcher Service

ServerSkan and ServerScan Directory Watcher Service are installed in an on- premises envir-
onment while the WorkZone database is installed in the cloud.

/ On-Premises

ServerScan Server

ServerSkan

WorkZone

Database

g

Folder: C:\ScannedDocs

Directory Watcher

ServerSkan scans documents and copies or creates XDI folders that contain the scanned
documents. The XDI folders are located in a specific folder that ServerScan Directory
Watcher Service monitors. In this example, the monitored folder is: C:\\ ScannedDocs. You
can configure the folder to be monitored before you install ServerScan Directory Watcher
Service. See Install ServerScan Directory Watcher Service.

ServerScan Directory Watcher Service reads a metadata file named sjFesdPacket.xm| and
uploads the documents with their metadata to the corresponding cases in WorkZone using
OData. See Sample metadata XML templates.

The ServerScan Directory Watcher Service supports:

* Windows 10 Pro (version 22H2) with 64- bit
* Windows Server 2022 with 64- bit

* Windows Server 2019 Standard with 64- bit
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Note:

* The case number must be specified for the documents. This release of Server-
Scan Directory Watcher Service does not support upload of documents
without case numbers to WorkZone.

e The maximum size of a document that ServerScan Directory Watcher Service
can upload to WorkZone is 178 MB, but it can vary depending on the network
bandwidth.

See also:

WorkZone Content Server Imaging Installation Guide (2024 .4)

ServerSkan brugervejledning (in Danish)

Install and configure ServerScan Directory Watcher Service

Prerequisite:

e .NET 8 SDK (Download .NET 8.0) .

* Accessto ODatato update the documents and metadata for respective cases
(URL).

* Permission to use a Microsoft Windows Installer (MSI) file to install the
ServerScan Directory Watcher Service.

* Application ID and secret, and Tenant ID of the WorkZone application.
* Windows Server 2022 with 64- bit.

e All Danish names must be replaced with English namesin XSLTToSj.xsl file.
See Sample metadata XML templates.

e Accessto login.microsoftonline.com from ServerSkan.

* Thefilesin the Components folder must be located in the installation pack-
age.
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* Make sure that the following information types (custom labels) exist in
WorkZone:

Of the type AO (dokumentoplysning):

* SSURI (File path of the scanned document)

* AO (Document)

* IndScanPers (Person who scanned the document)
* IndScanSide (Number of pages)

* IndScanTid (Time of scanning)

Of the type AP (Aktpart):

* Forfatter (Author)

* Afsendt af (Sent by)

* Afsendt fra (Sent from)
* Modtager (Recipient)

e CPR-nr (CPR No.)

If you do not have these information types, you can add them in WorkZone
Configurator. Go to Document > Informantion types. See Information types.

Note that you need to write the custom labels in lower case in the cfg filesin
the CFG folder. Read about the CFG folder in Configure WorkZone Content
Server Imaging (2024 .4).

App registration

Start by registering ServerScan Directory Watcher Service as an app in your Azure tenant.
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1 Follow steps 1and 2 only in Set up third- party integrations in Azure.

Note: While registering the app, make a note of Application (Client ID), Ten-
ant ID, Client Secret, and Enterprise Application Object ID.

2. Goto EntralID > App Registration, and select your app.

3. Click Go to Enterprise applications at the bottom right of the page.

GetStarted  Documentation

Build your application with the Microsoft identity platform

The Microsoft identity platform is an authentication service, open-source libraries, and application management tools. You can create modern, standards-
based authentication solutions, access and protect APIs, and add sign-in for your users and customers. Learn more

e & lﬂ’“ S ) )
. %@ m R

Call APls Sign in users in 5 minutes Configure for your organization
Build mare powerful apps with rich user and Use our SDKs to sign in users and call APIs in a few Assign users and groups, apply conditional access
business data from Microsoft services and your own steps. Use the quickstarts to start a web app, mobile policies, configure single sign-on, and more in
company’s data sources. 2pp, SPA, or daemon app. Enterprise applications.

View AP| permissions View all quickstart guides [ Go to Enterprise applications ]

4. Copy the Object ID (Enterprise Application Object ID) and paste it to, for
example Notepad, as you will need it later for configuration in WorkZone Con-
figurator.

Properties

MName ()
| KMD WorkZone - CATAKS - ... [ \

Application ID @

| D]
ObjectID @

| 154586¢5-75e2-4a2a-9df4-0... m

5. To configure the Enterprise Application Object ID in WorkZone, see Configure
APP Enterprise Application ID.
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Configure APP Enterprise Application ID

When you have registered ServerScan Directory Watcher Service as an app, you need to
configure the access to WorkZone in WorkZone Configurator.

1 Loginto WorkZone and open WorkZone Configurator.

2. Goto Global > OAuth settings > Integrations tab, and click [3 Edit next to the
XDISCANUSER account.
ﬁg WORKZONE configurator

Feature settings

Clients Integrations

Language settings
System messages
External databases
OAuth settings

0 FKCLAIMSADM
Access code filters
Validation rules @ INTEGRATION_1

System droplists
Custom droplists
Custom types
Mote types

Chat settings

Certificates

[0 KDISCANUSER ]

3. Enter the Enterprise Object ID of the Azure Entra ID app in the Object ID field,
turn on Allow to act on behalf of other users, and select the security code 9 in
the Security code field.
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XDISCANUSER - OAuth integration setting X
Object ID

Security code

9 - ‘) Allow to act on behalf of other users

Departmental access m Global access (2

Cancel

4. Click Save.

Download the folders

Before you can start the installation, you need to download two folders from the release
drive ..\Release\WorkZone Directory Watcher:

* Deployment folder that contains the deployment script for automatic installation
and configuration files.

* WZSS Setup folder that containsthe installer.

Install ServerScan Directory Watcher Service

Prerequisite: To install and uninstall ServerScan Directory Watcher Service, you need
to have administrative rights.
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Run the installer

1 Right- click Windows PowerShell and select Run as Administrator.

2. Gotothe WZSS Setup folder that containsthe KMD.WorkZone.Server-
Scan.Setup.M Sl file.

3. Thetable below showsthe parametersthat are required to install ServerScan
Directory Watcher Service:

Parameter Description Example

DIRECTORYWATCHE- Path to the folder to C:\ScannedDocs

R monitor for scanned
documents.
SCHEMA Path to the Com- C:\Components\Schedules\

ponents\Schedules
folder.

The folder must be
named as shown in the

example.
TRANSFORMATIONS Path to the Com- C\Components\Trans-
ponents\Trans- formations\

formation folder.

The folder must be
named as shown in the
example.

ERRORPATH Path to the folder that C:\Logs\Errors
stores error files.

OUTPUTPATH Path to the folder that C:\ProcessedDocs
stores processed files.

CLIENTID Azure application cli-  12345678-1234- 1234- 1234-
ent ID. 123456789abc
TENANTID Azure tenant ID. 87654321- 4321- 4321- 4321-
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Parameter Description Example
abcdef123456
CLIENTSECRET Encrypted Azure applic- EncryptedValue

ation client secret. See Encrypt the secret.

REDIRECTURL Redirect URL for OAuth https://localhost
authentication

AUTHREQUESTURL URL for authentication https://<domainname>/.default

requests. Replace <domainname> with
your domain name.
ODATAURL URL for OData API. https://<-

domainname>/odata/v3

Replace <domainname> with
your domain name.

PROTOCOLANDHOST Protocol and host for  https://<domainname>

communication Replace <domainname> with

your domain name.

LOGPATH The path to the folder <log file path>\\log.txt
that storeslogsthat
are generated daily.

Replace <log file path> with the
location of logsto be generated.
For example: " C\\WZ\\WZSS\\ -
log.txt"

4. Use the following command to install the .MSI with all parameters. Replace the
placeholders with actual values:

msiexec /i "KMD.WorkZone.ServerScan.Setup.msi" DIRECTORYWATCHER-
R="C:\ScannedDocs" SCHEMA="C:\Components\Schedules\"
TRANSFORMATIONS="C:\Components\Transformations\" ERRORPATH-
H="C:\Logs\Errors" OUTPUTPATH="C:\ProcessedDocs" CLIENTID-
D="12345678-1234-1234-1234-12345678%abc" TENANTID="87654321-
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4321-4321-4321-abcdefl23456™ CLIENTSECRET="EncryptedValue"
REDIRECTURL="https://localhost" AUTHREQUESTURL-
L="https://<domainname>/.default" ODATAURL-
L="https://<domainname>/odata/v3"
PROTOCOLANDHOST="https://<domainname>" LOGPATH="<log file

path>\log.txt" /g

Note: If a parameter value contains spaces, enclose parameter value in
single quotes ' when you passthe command. For example:
DIRECTORYWATCHER=""C:\testwzss\Scanned Documents\"'

5. Start the service with the following PowerShell command:

Start-Service -Name "KMD WorkZone Directory Watcher Service"

Encrypt the secret

1 Gotothe EncryptionHelper.pslfile in the Deployment folder.

2. Open Windows PowerShell in administrative mode and run the command.

.\EncryptionHelper.psl -encryptText "<Secret>"

3. Copy the Encrypted text and update the ClientSecret value.

Note: Encryption must be done on the machine where ServerScan Directory Watcher

Service will be running.

Sample metadata XML templates

i Sample metadata file (XML file)

i English names (XSL file)
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Danish names are no longer supported but you can use this file to map Danish namesto
English names:

i Mapping of Danish names to English names (XML file)

Uninstall ServerScan Directory Watcher Service

1 Navigateto the location where you saved the original .M Sl installation file.

2. Right-click the .MSlI file and select Uninstall. This will start the uninstallation
process.

If any error occur while uninstalling, follow these steps:

1 Open PowerShell as an Administrator.

2. Run these commands:

e sc.exe stop "KMD WorkZone ServerScan Service"

e sc.exe delete "KMD WorkZone ServerScan Service"

Confirm removal of the installation folder

When you have uninstalled the service, verify that the folder has been removed (C:\Pro-
gram Files (x86)\KMD.WorkZone.ServerScan). If the folder still exists, you can delete it
manually. Administrative rights may be required.
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Access codes

Access codes

The table below provides an overview of access codes and what they give access to. Usu-
ally the mandatory system access codes are created by script, but if they do not exist in
your Active Directory, you must created them manually.

WorkZone operates with three different types of access codes:

* Employee access code (associated with each user from Active Directory)
* Unit access code (associated with each Organizational unit from Active Directory)
* Group access code.

If your organization opted for an installation that utilizes the Corporate Access Code Sys-

tem (CACS), then all cases and documents are created with an access code string of a min-
imum of two access codes: an organizational access code and a group access code.

Access code More information

e Create or modify units.
* Work with del-

egates

e Organizational

e Assign organizational units as del-
egates on behalf of other users or

units.

AFDADM - units (For
F:reéte and r.nal.ntaln organ- WorkZone
izational units in WorkZone Con- Cloud Edition
figurator for WorkZone Cloud .

. ) . using
Edition installations using Microsoft)

Microsoft Azure Active Directory.

A corporate system access code.

If the Corporate configuration is chosen,

ALLEEMNER then the Access Code field of cases and * Corporate
access codes

documents must never be left blank.
Therefore, all objects of the system that
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Access code Usage More information

should be visible to all users must have
the ALLEEMNER access code. This is a sys-
tem access code that all users of the Cor-
porate configuration must be members
of.

CERTADM Not applicable in this release.

WorkZone Client:

* Configure and distribute
* Working with

WorkZone Client configurations.

_ WorkZone Cli-
e Edit templatesfor reports.
ent con-
WorkZone Configurator: figurations
Configure settings of: * Reports
* Work with del-
* WorkZone PDF Crawler
egates
* WorkZone PDF Engine « WorkZone PDFE
* WorkZone Explorer settings
CONFIGADM * WorkZone for Office « WorkZone for
Configure the following additional set- Office settings
tings: * WorkZone
Explorer con-
* Import and export WorkZone con- figuration

figurations e Custom types

e Custom types (requires also
DATAADM)

e Custom type

fields

* Custom type fields « Chat settings

e Document draft version
e Office Online Server

* Chat settings

DATAADM WorkZone Configurator: e Cases, doc-
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Access code Usage More information

Configure the following:

e Case number format

* Classification scheme (case
groups)

e Contact types (requires also
CONFGADM)

* Countries and postcodes
e Custom droplists
* Custom fields

e Date types
uments, and

* Default retention policy

o contacts
* Dictionary and keywords

e Custom types

e Document classification
e Custom type

e External databases .
fields

* Facets .
e Security group

rights

* Information types

* Import WorkZone configurations
(requires also CONFIGADM)

* Notetypes

* Parties and references

* Reason for document deletion

* Security group rights

* Subnumbers and subnumber
types

* Supported file types

¢ Validation rules

DELEGATEADM * Assign delegates for other users * Delegates
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Access code Usage More information

WorkZone Client:

¢ Move an archived document from

Move doc-
DEOURNALADM one case to another. Moving an ument

archived document to another
case islogged and traceable.

WorkZone Client:

Add hard copies and duplicates to
a document.
* Accept adistribution of a hard

HARDCOPYADM document or a duplicate on
behalf of another user.

e Manage hard

copies of a doc-

ument
* Destroy a hard copy or a duplic-

ate.

e Cancel adestruction of a hard
copy or a duplicate.

Call WorkZone Content Server Open WS
and gain access from athird party sys-
tem. The system user of the third- party

FESD_WS system isthe member.
The FESD_ WS access code is an externally
used system access code.
Enable and disable WorkZone features
LICENSEADM and modules in the WorkZone Con- * Feature set-
figurator. tings
WorkZone Client:
Edit the Hidden Dashboard list. The Hid-
den Items menu group contains the fol-
LOSTANDFOUND d P e Hidden entities

lowing sub- menus:

e Cases
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Access code Usage More information

* Documents

e Contacts

Prerequisite: Users must have the *
access code to display, open and
edit the displayed hidden items.

Displays the Mass dispatch processin the
e Start Mass Dis-

MASSDISPATCH Process menu in WorkZone Client and
allows usersto start a new mass dispatch. patch
Allows users to send the documents using e About Mass Dis-

MASSDISPATCHSEND ,
the Mass dispatch process. patch

* Create or modify employees.

* Assign departmental access codes
to other users (you must also
MEDARBADM have the AFDADM and
STERNEADM access codes and
the WorkZone Corporate Edition
installed).

e Active Dir-
ectory

WorkZone Client:

* View and edit up to 500 list items
on a page.
Users that are not assigned the
MULTIEDIT access code can view
and edit up to 50 list itemson a

page.

e Work with mul-

MULTIEDIT
tiple list items

Set up and configure the OAUTH2 frame-

OAUTH2ADM o
work for WorkZone connectivity.
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Access code Usage More information
WorkZone Configurator: * Process set-
tings
* Define general Process settings
* Processlogs
* Configure processes, service work-
* Export and

flows, and case activities
PROCESSADM deploy case

» Access process logs. activity graphs

WorkZone Process: * Unlocking a

locked task

* Unlock atask locked by another « Work with del-

user.
egates
WorkZone Configurator:
* Process pack-
PROCESSDEV * Add and update process packages ages

in WorkZone Configurator,

WorkZone Client:

* Change theretention policy on a « Meta data

case. fields
RETENTIONADM
WorkZone Configurator: e Retention

policies
e Set up and maintain retention

policies.

Reassign the ownership of shared
SEARCHADM searches, for example if the original
owner is unavailable.

WorkZone Client:
¢ Delete a case

¢ Send cases and archived doc- e Restore a
SOFTDELETE umentsto the recycle bin. deleted case
¢ Restore cases and archived doc- e Delete adoc-
uments from the recycle bin. ument
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https://docs.workzone.kmd.net/2025_0/en-us/Content/WZClient_UserGuide/Case/About_fields.htm#Meta
https://docs.workzone.kmd.net/2025_0/en-us/Content/WZClient_UserGuide/Case/About_fields.htm#Meta
https://docs.workzone.kmd.net/2025_0/en-us/Content/WZCnF_AdminGuide/Policies/Main.htm
https://docs.workzone.kmd.net/2025_0/en-us/Content/WZCnF_AdminGuide/Policies/Main.htm
https://docs.workzone.kmd.net/2025_0/en-us/Content/WZClient_UserGuide/Case/Manage_cases.htm#Delete
https://docs.workzone.kmd.net/2025_0/en-us/Content/WZClient_UserGuide/Case/Manage_cases.htm#Restore
https://docs.workzone.kmd.net/2025_0/en-us/Content/WZClient_UserGuide/Case/Manage_cases.htm#Restore
https://docs.workzone.kmd.net/2025_0/en-us/Content/WZClient_UserGuide/Document/Manage_documents.htm#Delete
https://docs.workzone.kmd.net/2025_0/en-us/Content/WZClient_UserGuide/Document/Manage_documents.htm#Delete

KMD

WorkZone WorkZone Cloud Edition 2025.0 Installation and Operations Guide

Access code Usage More information

* Delete cases and documents per-
* Restorea

manently if you have access code
deleted doc-

associated with the case's or doc-

: . ument
ument's retention policy.

WorkZone Configurator:

Grant other users global access (requires
having also the MEDARBADM access
code) or departmental access (requires
having also the MEDARBADM access code
and the WorkZone Corporate Edition
installed).

* Global access: Grant users full
access (read, write and delete
rights) to all items within the
entire organization.

* Departmental access: Grant users * Global and
full access (read, write and delete departmental
rights) to all items within the access

STERNEADM

department the user isa member
of.

Important: Global and departmental
access allow users view and edit
items (cases, documents, contacts,
meetings or actor sequences) pro-
tected by security access codes that
the user is not a part of.

Global and departmental access are
extensive rights that will allow the
user to access sensitive inform-
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Access code Usage

ation. Assign these rights only when
needed.

More information

WorkZone Process:

Configure.
TEMPLATEADM « Create templates for standard let- standard let-
ters used by SmartPost. ters
_ _ Users (for on-
Access and configure in WorkZone Con- .
_ premise
figurator:
WorkZone
.« Users installations)
* Use Logs Use logs
USERADM : i
* Deletion Logs Deletion logs
* Assign usersto unitsin WorkZone Users (For
Configurator for WorkZone Cloud WorkZone
Edition installations using Cloud Edition
Microsoft Azure Active Directory. using
Microsoft)
WorkZone Configurator: Use log set-
tings
USH OGADM * Configure the use log settings and .
_ . Deletion log set-
deletion log settings. .
tings
Obsolete access codes

New access codes are sometimes introduced in new WorkZone versions as they are needed

and existing access codes can also be updated, changed or removed from use, becoming

obsolete.
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While obsolete access codes no longer are present in the WorkZone program or referenced

by WorkZone applications, they may still be present in local, converted databases asthe

upgrade process does not remove existing access codes, obsolete or not.

The following access codes are currently obsolete.

Access Code Notes

ABBADM

CONTENT_ SERVICES

DIAGADM

FILINGPERIOD

LISTCONF

LUKKET

MENUCONF

MODESAG

PHRASEEDIT_ DEPARTMENT

PHRASEEDIT_ ORGANIZATION

PHRASEEDIT_ USER

POST

PROFLADM

A system access code for enabling the Subscription
Administration menu item

Enable and disable Content Services.

Used for tracing logsin the now discontinued
WorkZone Configuration Management (Diagnostic mod-
ule).

Used in the now discontinued Captia Web Client.

A system access code for enabling Filing Period menu
items.

Used in the now discontinued Captia Web Client.

A system access code for list configuration.

Used to manage access in the Meeting module for the
now discontinued Captia Web Client.

A system access code for menu configuration.

Used to manage access in the Meeting module for the
now discontinued Captia Web Client.

Used to manage accessto the obsolete and withdrawn
Phrases module.

Used to manage access to the obsolete and withdrawn
Phrases module.

Used to manage access to the obsolete and withdrawn
Phrases module.

Used to manage access to mail lists.

Used in the now discontinued WorkZone Configuration
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Access Code Notes
Management.

Used to manage access to Sysadm profile admin-
istration module.

A system access code which provides access to old
RAPDEF reports created with Crystal Reports (3" party
product).

Displays the Advanced submission (Extended) process

in the Process menu in WorkZone Client and
STEPSUBMISSION )

WorkZone for Office, and allows users to start

advanced submissions.

Used in the now discontinued WorkZone Configuration
TERM SADM Management to set up and maintain the Terms mod-
ule.

Used to manage access to relation unlocking menu

UNLOCKADM items.

WORKFLOWADM Obsolete Workflow access code.
WORKFLOWCREATE Obsolete Workflow access code.
WORKFLOWSUBSTITUTE Obsolete Workflow access code.

WORKFLOWSUBSTITUTEGLOBAL Obsolete Workflow access code.

Used to manage access in the Meeting module for the
now discontinued Captia Web Client.

AABEN

Important: The table above is not a list of access codes which should be deleted.
Instead, it is a list of access codes which WorkZone no longer uses or references.

The list should be used as a base for further investigation of potentially removable
access codes.
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Configure Entra ID

Follow the procedures below to provision users from Entra ID to WorkZone - Cloud Edition.
You can use this setup if you do not replicate users from on- premises AD but only use
Entra ID.

Register WorkZone apps in Azure

WorkZone Entra ID registration

WorkZone uses the Microsoft identity platform for identity and access management tasks.
To set up atrust relationship between WorkZone and the Microsoft identity platform, the
WorkZone application must be registered. This app registration is created by KMD during
WorkZone installation, and an Enterprise application representing this app registration is
created in the customer’s Entra ID tenant when first users access the WorkZone instance.

The WorkZone SharePoint and WorkZone Process modules require additional application
registrations. These need to be created by the customer in their Entra ID tenant.

Create a WorkZone Enterprise application

Prerequisite:

Thistask must be performed by a user with permission to grant an admin consent in
Entra ID (that is, at least a Privileged Role Administrator).

To create WorkZone Enterprise application, open the link provided by the WorkZone con-
sultant. This link will redirect you to WorkZone, and you will need to consent for the
required permissions on Entra ID.

Register the WorkZone Process application

An additional registration is needed to send emails from WorkZone Process. This regis-
tration will allow interaction with Exchange Online. Because the privileges that are granted
are broad, the application access must be scoped down to one mailbox.

To create an application registration for WorkZone Process, run the New-KmdWorkZoneEx—
changelApp.psl script.
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The script uses the following parameters:

* DisplayName: Display name of the Entra app.

e TenantId: Entra Tenant ID.

IdentifierUriPrefix: Unique name prefix used for application registration Uri.

* ExchangeOnlineAuthFlow: ClientCredential (recommended) or PublicClient.

Example:

. \New-KmdWorkZoneExchangeApp.psl
-DisplayName 'KMD WorkZone - Production - Exchange'
—TenantId XXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXX
-IdentifierUriPrefix 'Production'

-ExchangeOnlineAuthFlow ClientCredential

See Command line configuration of WorkZone Process for more details.

The script will output a client (application) identifier, tenant ID, and a client secret that
must be delivered to KMD.

After running the script:

1 Inform KMD about the client (application) identifier, tenant ID, and a client
secret that the script returns.

2. The script also returns the following message:" Permissions for this App
requires Admin Consent. Please go to Azure Portal and 'Grant Permission' for
this App or go directly to this consent url and log in as an AAD Admin (ignore
that the redirect in the end might not work)" . Follow the instructionsin the
message to grant Admin Consent to the WorkZone Process application.


https://docs.workzone.kmd.net/2025_0/en-us/Content/InstallGuide/Install/Process/Configuration_Command_Line.htm
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Secure WorkZone Process application registration

Important:

Application access must be limited to a single mailbox used by WorkZone Process
using an application access policy. For more information, see the Microsoft doc-
umentation Limiting application permissions to specific Exchange Online mailboxes.

Use the PowerShell script Set-WZPAppRegistrationScope.psl to set the access
l[imitation.

Prerequisite:

The script requires that the PowerShell ExchangeOnlineManagement module is
installed. Before you execute the script, you need to connect to Exchange Online by
running:

Connect-ExchangeOnline -UserPrincipalName <Exchange administrator

account>

The following parameters are required by the script:

* wzpMailbox: The mailbox that the application should have access to.

* wzpAppId: The application (client) ID of the WorkZone Process application regis-
tration.

* groupName: Name of the Entra group that manages security for the application
registration.

Example:

.\Set-WZPAppRegistrationScope.psl
-wzpMailbox example@yourdomain.com
—WZPAPPId XXXXXXXX-XXXKX-XXXX=KXXXKX=XXXKXXKXXKXXKXX

—-groupName "KMD WorkZone Process Production"
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Register the WorkZone SharePoint application

Follow these stepsto register the WorkZone SharePoint application at Entra ID (thisis a
prerequisite for using the WorkZone SharePoint module to copy the documents from
Microsoft SharePoint to WorkZone).

Thisisdone viathe New-KmdWorkZoneWZSPApp.psl script provided by KMD technicians.

Prerequisite: You must have the Entra and Azure Az Powershell modules installed,
and the Entra admin consent.

Run the New-KmdWorkZoneWZSPApp.ps1 script, using the following parameters:

* DisplayName: Display name of the AD app. For example, KMD WorkZone - WZSP.

* TIdentifierUri: Identifier URI of the AD app that is also used for updates (script
re- runs)

* TenantId:your Entra Tenant ID
Example:
.\New-KmdWorkZoneWZSPApp.psl
-DisplayName 'KMD WorkZone — WZSP'
-IdentifierUri 'api://5d3760£f7-9e2f-4bf3-a318-b0ea87f66540/wzsp’

-TenantId ‘5d3760f7-%e2f-4bf3-a318-b0ea87£66540’

Enroll WorkZone - Cloud Edition in Azure and set up SCIM provisioning

To enroll a new WorkZone instance in Microsoft Azure and set up SCIM (System for Cross-
Domain Identity Management) provisioning users and groups from Entra ID to WorkZone,
you must complete the following steps:

1. Associate UPN with WorkZone SCIMADMIN account

2. Generate secret token

3. Set up Microsoft Entra enterprise application

4. Configure automatic provisioning for the enterprise application

5. Assign users and groupsto the enterprise application
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1. Associate UPN with WorkZone SCIMADMIN account

Prerequisite: You need to know the User Principal Name (UPN) from an existing
account in your organization's Azure tenant that you want to associate with the
WorkZone SCIMADMIN account.

To associate the UPN with the WorkZone SCIMADMIN account, run the following SQL
against your organization’s WorkZone - Cloud Edition database:

update users set upn=(UPN) where user name='SCIMADMIN'

e The UPN is case sensitive.

* Note that technicians often carry out this task.

2. Generate secret token

You need to generate a secret token for use in your Entra ID enterprise application setup
of the WorkZone provisioning.

1 Log on with the account from step 1
2. Open WorkZone Configurator and go to Services > SCIM Provisioning.

3. On the SCIM Provisioning page, generate a token and copy it for usein
theEntra ID Enterprise Application.

See SCIM provisioning in the WorkZone Configurator Guide.

3. Set up Microsoft Entra enterprise application

Create a new Entra enterprise application registration to be used for SCIM provisioning to
WorkZone. The setup of the Entra enterprise application depends on whether your
WorkZone - Cloud Edition instance is publicly accessible or not publicly accessible.

WorkZone - Cloud Edition is publicly accessible

For WorkZone Cloud Edition setups where WorkZone is publicly accessible, you need to cre-
ate a new non- gallery application for provisioning in your Azure tenant as shown below.
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1 In Azure Portal, go to Microsoft Entra ID > Manage > Enterprise applications.
2. Create anew application.

3. Enter aname for the application, for example KMD WorkZone - [envir-
onmentname] - SCM.

4. Select Integrate any other application you don't find in the gallery (Non- gal-
lery)

5. Click Create..

See the Microsoft article Integrate your SCIM endpoint with the AAD SCIM client for
instructions on how to create a non- gallery application.

WorkZone - Cloud Edition is not publicly accessible

If the WorkZone servers are not publicly accessible, for example when they are hosted in a
lab and you want to test or develop in the lab, you will need to use the gallery app named
On- Premises SCIM app, and additionally install a SCIM agent on the web server.

See the Microsoft article Microsoft Entra on- premises application provisioning to SCIM -

enabled apps for instructions on how to create an on- premise application.

4. Configure automatic provisioning for the enterprise application

For both public and non- public WorkZone - Cloud Edition instances, you will need to con-
figure automatic provisioning for the enterprise application that you created in step 3.

1 Under Admin Credentials, enter the address to the WorkZone Provisioning
SCIM web service. For example, https://CUSTOMER. -

workzone.cloud/provisioning/scim.
2. Enter the secret token that you generated in step 2 in the Secret Token field.

3. Click Test Connection to test the connection.
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Provisioning

Provisioning Mode

Use Azure AD to manage the creation and synchronizat
and Qroup asgnment

w  On-Premises Connectivity

~ Admin Credentials

Admun Credentuals

Azure AD needs the following information o cone

Tenant URL *

http//syunittest/provisioning./scim

Secret Token

Test Connection

4. Click Save.
5. Reopen the Provisioning. The Mapping tab is now available.

6. Under Mappings, leave the default settings for mapping users and groups asis
to use the default mapping scheme that Azure offers. The default settings are
displayName, Objectld, and members. If you want to provision group descrip-
tions from Entra ID to WorkZone or add guest users, you need to create addi-
tional mappings.

Group description

The group description in Entra ID provides additional information about a
group. The description can help you identify the group after the group has
been provisioned to WorkZone and added to the AccessCodeDomain table as
an access code. The group description in Entra ID is not part of the default
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mapping scheme, so you will need to add the mapping before you start the pro-
visioning.

Follow the steps below to provision the group description from EntraID to
WorkZone:

Select your " SCIM provisioning” app.

Go to Provisioning and click Edit attribute mappings.

1
2
3. Expand Mappings and click Provision Microsoft Entra ID Groups.
4. On the Attribute Mapping page, click Add New Mapping.

5

Select Description in the Source attribute field and urn:i-

etf:-
params:scim:schemas:extension:WorkZone:2.0:Group:description
in the Target attribute field.

Important: If urn:i-

etf:-

param-

S:scim:s-
chemas:extension:WorkZone:2.0:Group:description
attribute is not available for selection, your Azure admin-
istrator must add it as follows:

a. Under Provisioning, click Provision Microsoft Entra
ID Groups.

b. Under Attribute Mappings, select the Show
advanced options checkbox.
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Attribute Mapping

Save X Discard

Name

‘ Provision Microsoft Entra ID Groups

Enabled
“:7 Yes No :w

Source Object

‘ Group

Source Object Scope

All records

Target Object

‘ urniietf:params:scim:schemas:core:2.0:Group

Target Object Actions

Create

Update

Delete

Attribute Mappings

Attribute mappings define how attributes are synchronized between Microsoft Entra ID and customappsso

customappsso Attribute Microsoft Entra |
displayName displayName
externalld objectld
members members
urnzietf:params:scim:schemas:extension:WorkZone:2.0:Group:description description

Add New Mapping

Show advanced options

Supported Attributes

View and edit the list of attributes that appear in the source and target attribute lists for this application.

The attribute list for Microsoft Entra ID is up to date with all supported attributes. Request additional attributes you would like to see s
Edit attribute list for customappsso

Use the expression builder

In addition to configuring your attribute mappings through the user interface, you can review, download, and edit the JSON represent:

c. Click Edit attribute list for customappsso.
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d. Createanew urn:i-
etf:-
param-
S:scim:s-
chem-
as:ex-
tension:WorkZone:2.0:Group:description

attribute, and click Save.

Edit Attribute List

5
H

prouuLr s
pocousC s
[N < RN
ooonorna

Name Type ult-Velue? Exact case? API Expression

<

Theurn:i-

etf:-

param-

S:scim:s-

chem-

as:ex—
tension:WorkZone:2.0:Group:description
attribute should now appear for selection in the
Target attribute field.

Guest users

If you want to invite people that are not part of your organization to col-
laborate with you in WorkZone as guest users, you will need to do additional
mapping. See Add guest users.
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7. Save the configuration.

5. Assign users and groups to the enterprise application

Assign the relevant users and groupsto the application and start the automatic pro-
visioning See Provision Entra ID to WorkZone.

Entra ID runs the provisioning service runs every 40 minutes. During the provisioning,
users and groups are added to a set of staging tables in the WorkZone database, and a
WorkZone - Cloud Edition application named Sourcelmport.exe creates the WorkZone
users and assigns access codesto them based on the data in the staging tables.

It isrecommended that technicians set up a scheduled task that will run this application
every 40 minutes.

The command line to use is:
SourceImport.exe /mode=AZURE AD /db=<Name of WorkZone database>
For example:

SourceImport.exe /mode=AZURE AD /db=db0l

Note: It may take about 80 minutes for changes to users and groupsin Azure to be
completed in WorkZone - Cloud Edition.

Staging tables
The three most important tables that are populated with data from Entra ID are:

« SCIM_ USER
« SCIM_ GROUP
« SCIM_ GROUP_MEMBER

The SCIM_ GROUP_ MEMBER table contains the connections between users and the
groupsthat they are member of as well as connections between nested groups.
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Group name restrictions

The following restrictions apply to the AD Group name (pre- Windows 2000) field in global
security groups used for group access codes.

* All letters are converted to upper case when transferred.
* Maximum 30 characters are converted, additional characters are truncated.
* The only letters and digits allowed are:

° Atoz

° 0through 9.

* The only special characters allowed are:

° Underscore ()

° Dash (-).

e The characters &, ¢ and A are converted as shown below:

° E=ARE
° g=0E
° A= AA.

Important: E, @, and A are treated as two characters.

* All special characters other than the above will be removed.

* Space is converted into dash (-).

Provision Entra ID to WorkZone

WorkZone uses users and groups from Entra ID. In WorkZone, users represent WorkZone
users and groups represent security codes, access codes, and profiles.

Entra ID runsthe provisioning of users and groups from Entra ID to WorkZone - Cloud Edi-
tion every 40 minutes. See 5. Assign users and groupsto the enterprise application.
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Group for WorkZone security codes

The attribute display name must start with a prefix. By default, thisis ‘wz SEC ’ fol-
lowed by a digit 1to 9, for example ‘Wz SEC_6’. The formal display name definition is
<prefix><n> where n can be a digit from 1to 9.

The prefix must be the same for all WorkZone security groups.

Only users can be members of security groups. If a user is member of more than one
WorkZone security group, the security code assign to the user will be the highest one.

Group for WorkZone access codes

The attribute display name must start with a prefix. By default, thisis ‘wz_aAcc ' followed
by the access code, for example ‘Wz ACC ALLEEMNER’. The formal display name defin-

ition is <prefix><access code>
The prefix must be the same for all WorkZone access codes groups.

Only users can be members of access code groups.

Group for WorkZone - Cloud Edition profile groups

The attribute display name must start with a prefix. By default thisis ‘wz_ PRO ’ followed
by the profile name, for example ‘Wz PRO OFFICER’. The formal display name definition

IS <prefix><profile name>.
The prefix must be the same for all WorkZone profile groups.

Members of profile groups can be users, access code groups, profile groups, and security
groups.

Only one security group is supposed to be member of a profile. If there are more than one
security group, the highest security code is assigned to the profile.

The access code assigned to a profile isthe union of access code membersin the profile
and all other profilesthat the profile group s member of directly or indirectly.

Example: If the WZ_ PRO_ OFFICER profile group hasthe WZ_ ACC_ ALLEEMNER
access_ code group as member, and the WZ_ PRO_ ADMIN profile group hasthe
WZ_ACC_ADMIN access_code group and WZ_ PRO__ OFFICER profile group as mem-
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er,then WZ_ PRO_ADMIN profile group will be assigned ALLEEMNER and ADMIN
ccess code.

A user’s security code

If a user is member of more than one security group, directly by being member of a
WorkZone security group or indirectly by being a member of a WorkZone profile group, the
following rule applies:

* Direct membership overrules indirect membership, and the highest security code
Is used.

* If auserisnot member of any WorkZone security group, the user is not replicated
to WorkZone.

A user’s access codes

The access code that will be assigned to a user isthe union of the access code from the
access code group that the user is member of and access code that is assigned to the pro-
filesthat the user is member of.

Mapping of columns for a user

WorkZone - Cloud
Entra ID Note

Edition

Users.user_ name,

1 . Name.name_ code The characters from beginning up to the @ character is
ser prin-

inal (name_type = transferred, it must not exceed the number of characters
cipa
Np ‘M’) defined in contact type for name_type M, no more than 30
ame
Employee.name_ characters.
code
User prin-
cipal Users.upn Must be maximum 512 characters long.
Name
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WorkZone - Cloud

Entra ID "
Edition
First Name.namel
name Employee.namel
Last Name.name2
name Employee.name2
Name_ address.ad-
dressl
Steeet
address Name_ address.ad-
dress2
(work)
Name_ address.ad-
dress3
Country
or region Name_address.-
country
(work)
Zip or
postal
code Name.post_ code
(work)
Office
Name_ address.-
phone
phone_no
(work)
Mobile
Name_ address.-
phone
i cell_phone_no
(mobile)
Email :
Name.email
(work)

Note

Maximum 60 characters istransferred.

Maximum 60 charactersistransferred.

Maximum 150 characters in addressl, 2, and 3, but trying to
split by a blank character. It means that maximum 450
characters will be transferred.

Only transferred, if it matches a country in the WorkZone
country table. (1SO alfa2 standard).

Only transferred, if it matches a postal code in the
WorkZone postcode table.

Must be maximum 25 characters long, otherwise it will not
be transferred.

Must be maximum 25 characters long, otherwise it will not
be transferred.

Must be maximum 255 characters long, otherwise it will
not be transferred.
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Creating Organizational units for WorkZone Cloud Edition

If you are operating WorkZone Cloud Edition, the creation and maintenance of your organ-
izational units and unit hierarchy must be performed in WorkZone Configurator > Organ-
ization > Organizational units because Microsoft Entra ID does not currently contain
features for the creation and maintenance of organizational units required for WorkZone
user administration and hierarchical structure.

Prerequisite: You must be assigned the AFDADM access code to create and edit
organizational units in your WorkZone Cloud Edition installation.

On- premise WorkZone installations must utilize an on- premise Microsoft Active Directory,
which does contain features for the creation and maintenance of organizational units.

Assigning WorkZone users to organizational units

For WorkZone Cloud Edition, WorkZone users cannot be assigned to organizational units
directly in the Microsoft Entra Connector. Instead, WorkZone users created in the
Microsoft Entra ID can be assigned to organizational unitsin WorkZone Configurator

> Organization > Users.

Prereguisite: You must be assigned the USERADM access code to view and assign
unitsto usersin your WorkZone Cloud Edition installation.

See also:

Organization units (for WorkZone Cloud Edition)

Users (for WorkZone Cloud Edition)

Add guest users

You can invite people that are not part of your organization to collaborate with you in
WorkZone as guest users. You can, for example, collaborate on cases and documents with
users across organizations, or you can share access to a WorkZone instance with, for
example, subject matter experts or consultants to collaborate on and share the inform-
ation that they need for specific purposes.
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To set up guest users, follow these steps:

1 Set up SCIM provisioning of guest users from Entra ID to your WorkZone ten-
ant.

2. Invite the guest usersinto your tenant.

3. Assign WorkZone groupsto the guest users.

Note: WorkZone Mobile does not yet support guest user access.

Set up SCIM provisioning of guest users

Prerequisite: Upgrade to WorkZone 2023.2 before you configure guest users.

Guest users do not have a UPN (User Principal Name) as part of their token as internal
WorkZone users do when they sign in to your WorkZone tenant, see Enroll WorkZone -
Cloud Edition in Azure and set up SCIM provisioning. When provisioning guest usersto
WorkZone, Microsoft Azure Object ID is used instead of UPN to identify users.

To make sure that guest users can log in to WorkZone after SCIM provisioning, you need
to map Azure Object ID to the Externalld attribute.

Map Azure Object ID

1 Signintothe Azure Portal as an Entra administrator.

2. Goto Enterprise Applications and select your " SCIM provisioning" app.
3. Go to Provisioning and then click Edit attribute mappings.

4. Expand Mappings and click Provision Azure Active Directory Users.

5. On the Attribute Mapping page, click the Externalld attribute, and change the
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source attribute to Objectld. If the Externalld attribute does not exist, you can
add it.

Invite guest users

Invite guest usersin to your tenant from the Azure Portal. Guest users use their own
accounts. You must have arole as an Entra administrator to be able to add guest users.
Read more about adding guest users and sending invitations in the Microsoft Entra doc-
umentation, for example in the Microsoft article Quickstart: Add a guest user and send an
invitation.

Naming convention for guest users

When a guest user that has an email address with another domain than your primary
domain, the user name of that guest user will be <Username_ 1>, where the suffixed num-
ber isarunning number that ensures that no username is used twice for different users.

Important: It isrecommended that your organization uses unique usernames for
your users, even if you use subdomains. If your organization does not maintain a
unique naming of their users across the primary domain and its subdomains, non-
unique users will named as guest users.

Example

At your organization, your domain is organization.com. Your e- mail address is abc@or-
ganization.com and therefore, your WorkZone username is 'abc'.

You create a guest user account for an external consultant, whose e- mail address is
"abc@othercompany.com'. WorkZone does not recognize thisdomain as your primary
domain, and therefore creates the user as abc_ 1

The user abc_ 1's colleague is also invited to work on the project as a guest user. Their e-
mail address is xyz@othercompany.com. Even though there is no other user in your organ-
ization with that user name yet, the user is still created as xyz_ 1, because their domain is
not the same as your primary domain.
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Assign groups to a guest user

1 Signintothe Azure Portal as an Entra administrator.
2. Navigate to the external users, you have invited.

3. Goto Groupsto add WorkZone groups that represent security codes, access
codes, and profiles. See Provision Entra ID to WorkZone.

Remove a guest user

Delete a user from Entra ID

When you delete a guest user from your WorkZone tenant, the guest user will be able to
work and refresh an already opened WorkZone session for some time, depending on the
lifetime of the token. The user will not be able to log in to WorkZone on a new tab.

Close a contact in WorkZone

If you set an end date on guest usersin WorkZone, the users will be deleted from Entra ID.
See Close a contact.

Re- add a guest user

If you re- add a guest user, the guest user's UPN (email) is used to see if the user has had
access to WorkZone previously.

Set up third-party integrations in Azure

To configure a third- party app to integrate with WorkZone, you need first to register the
third- party app in your Entratenant, and then configure the access to WorkZone in
WorkZone Configurator. This topic describes how to set up integration accountsin Azure
Portal and get the information that you to need to configure the integration in WorkZone
Configurator. The third- party app SnapLogic is used as an example in the procedure
below.
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Set up an integration account in Azure

1 Inyour Entratenant, go to App registrations and create a new app registration.
You only need to fill in the name of the app, and then click Register.

= Microsoft Azure B Search resources, services, and docs (G+/) -

Home > NEC Australia - KMD Workzone | App registrations >

Register an application

* Name

The user-facing display name for this application (this can be changed later).

I Snaplogic Integration App w

Supported account types

Whao can use this application or access this API?

@- Accounts in this organizational directory only (NEC Australia - KMD Workzone only - Single tenant)

O Accounts in any organizational directory (Any Microsoft Entra ID tenant - Multitenant)

O Accounts in any organizational directory (Any Microsoft Entra ID tenant - Multitenant) and personal Microsoft accounts (e.g. Skype,
Xbox)

(O Personal Microsoft accounts only

Help me choose.

Redirect URI (optional)

We'll return the authentication response to this URI after successfully authenticating the user. Providing this now is optional and it can be
changed later, but a value is required for most authentication scenarios.

Select a platform o e.g. https://example.com/auth

Register an app you're working on here. Integrate gallery apps and other apps from eutside your organization by adding from Enterprise applications,

By proceeding, you agree to the Microsoft Platform Policies o

2. Goto Certificates & secrets. Add a client secret, and click Create.
(= oot ane

Haome & MEC Australia - KMID Wrkoons | App regittrations > Sraplogic Integration App Add a client secret
Snaplogic Integration App | Certificates & secrets =

Description [ Snaptogic Chent Secret

Search 5 Got tewcitack?

Lxpires L7328 mometny |

B Overcew

& Guidkstant Creduntialy snable confidentil appheations 10 Kentiy themsebves 10 the su
seherma, For & highar evel of assurance, we recomimend wsing & certifcate [
A Integeation maistant

Manage
[i ] ot socrets et

B Branding & propertes

Aathentecann
® Certificates {0} Client secrets (0)  Federated credentials (0
Cortficates & vacrets —_—

A icret string that The applcation uies 10 prove i identity when rgaiti

1 Token comtguraticn
& KR permasions 4 Hew chnt seoren
G Expoue an AR Description . .
B Approies
B Owneni

P clapent ancrets P berers ereated for thin, spplication

. Rolet and aderenirnnon
M Mantest

Support » Troublmhoating
£ Troubleshooting

& tew nppon regquest
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Important: Immediately after clicking Create, copy the client secret and
paste it to, for example Notepad, as you will need it later. Thisisthe only
time that the client secret is shown. If you do not copy it right away, then

you have to create a new client secret.
Ds.mwmmmm-n E

Home > NEC Austrakis - KMD Workzone | App registrations > Snaplogic Integration App

Snaplogic Integration App | Certificates & secrets =

Seaech 5 Got feedback?
B Overview
& Quickstart 10 Gota second 10 grve s some feetonc?
A integration assatant
edentials 1 12 dently 1o the suth g tokens a1 8 wrb addressable loction fusing as HTTFS

Manage schaeme). For & hig? o avinrance. 9 d of a cliert secret] 45 8 crodentisl
= Bancing & properties
D Authersication o - ey

Certificates & vecrets
11t Token configuraton Centficates (0)  Cllent secrets [1)  Federated credentials (0}

& AP permissions
A secret string that the appication uses 1o prove its khentity when requesting & token. Also can be refered 10 i appication piiswond.

& Exposs an AP

I App rotes. + Mew chent secret
& Ownens Deweription Expires s Secret ID e Coped o
& Roles and administrabors Seaplogs Chent Secret 10642025 [ ] }mms b mmz—nmmm?’!ﬁf’t
W Manitens

Suppent + Troublethasting
£ Troulewhooting

B New uppant RguEt

3. Go to Enterprise applications > All applicationsto see the object ID for the app
registration, in this example SnapLogic app.

Microsoft Azure K Spgerh resourres, senaces, and docs (G

Home : Enterprise applications

gz: Enterprise applications | All applications

BEE NEC Aurralia - KMD Werksone - Microsalt Erars 1D

1= MNew applcation 1.-_.- Refredl = Downlosd [Expon] ﬂ Prevview infla =L Columv [F Preview festured B
Chverview
O Overdiew View, filter, and search applicatiors in your organization that are et up bo e your Microsoft Entra tenant s their identity Provider
X Diagrase and sobee problems The list of appications that are maintained by your crganizaion are in spplication registrations
Marage H Search by applicaticn name or object iD Application type == [ prise Applicati - Application D starts with
B AN spplicatiors 4 applications found

4 et | -
B Privase Net connacion Hama & ObgactID Applicatian D Hemepags URL
B User sabtings . Snaplogic SAML 5 Be 0 -4 30 - B 36-E00eali TR TO 344b5e78-031E-4129-b.
B App lanchers . Snaplogic Integration App | STBBS2TE-2201-4868- ol 241832 164081 | 1165 T0b- 2641-4db1-
#' Custom authenbcation exbersons . AppCMCMG BAETEad-caT5-407T7 b 2ug -1 Sellebccd EfITh3d3-3ab6-4097 -8
(Previes)

. W NEC ALF SCIM Prosdsdoning dB053 311054393 b-a2bh 740 3659 Ob3ac8S-1130-4492-b.. hitps//accourls

Security

% Conditional Access

T Comuent and permisticra
ety

D Lagn-in bogs
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4. In WorkZone Configurator, go to Global > OAuth Settings > Integrationsto set
up the OAuth integration. Follow the stepsin the WorkZone Configurator guide

(Integrationstab). Enter the newly created object ID for the corresponding

enterprise application in the Object ID field. In this example, it isthe object
ID of the SnaplLogic app (see step 4).

INTEGRATION_1 - OAuth integration setting X

Object ID
INTEGRATION_1 57b8527h-2233-4868-affb-2418321b40a1
Security code
9 . @D Alow to act on behalf of other users

Departmental access

m Global access

5. Note down the Client ID, the Tenant ID, the Client Secret from before (see step
3), the OAuth2 endpoints and the WorkZone Application ID URI (both which
can be found on the App Registration for WorkZone).

Oauth?2 endpoints:

= Microsoft Azure B Search resources, services, and docs (G+/)

]
NEC AUSTRALIA - KMD woRxzo... S

Home Endpoints .
i WorkZone AU Demo #

OAwuth 2.0 authorization endpoint {v2)

o Search 0 pelete & tps/login.mic e com/S7d0T5H1-76a1-4bif-a050-TeT144193095 /oauth2 v 0fauthorize B
B Ovenview ) Okt 2.0 token endpaint (v2)

= Essentials
& Quickstart hitps:/login.mic ine.c 5§1-76a1-4bFf-a050-Te 7144193095 cauth2v2 Oftoken

Display name

" Integration assistant
Manage

= Branding & properties
3 Authentication

Certificates & secrets

flogin. I 1-76a1-4bff-a050-Te7144193095/v2.0/ well-known/openid-configuration (s}
e . Supported account types |
Il Token configuration e OrGanbation onke
i i Microsoft Graph AP1 endpoint
% AP permissions hitps.//graph.microsoft.com o
& Expose an API 0 Starting June 30th, |
:‘:“:‘:‘:"‘9 '-"’I_PPT_':‘ Federation metadata document

. ication Libri
BL App roles P in.mic i 5§1-76a1-4bff-a050-Te7 144193095 /2007-06/federati samil D
& Owners

L. Roles and administrators

 Manifest

WorkZone AU Demo

Application (client) ID
Se55ed86-2756-4c06-961

Object I
edbdf7df-Fibb-47e7-ack!

Directory (tenant) D
S7d075f1-76a1-4bff-a05(

Get Started  Docum

Ovwsth 2.0 authorization endpoint (v1)
hitps://loginmicrosoftonline. com/97d075f1-76a1 -4bff-a050-TeT 144193095/ cauth/authorize

Cuwrth 2.0 token endpaint (v1)
hittps//loginmi ine.c 76

1-4bff-a050-7e7144193095/cauthtoken

Open|D Connect metadata document

‘WS-Federation sign-on endpoint
hitps/loginmicrosoftonline.com/97d075f1-76a1 -4bff-a050-TeT 144193095/ wsfed

SAML-P sign-an endpoint
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Application ID URI:

Ty

Home > MEC Australia - KMD Workzone | App registrations >

:3 WorkZone AU Demo  #
Ly

£ Search J @ [i[ Delete @ Endpoints %4 Preview features
B Overview
. Essentials
& Quickstart
Display name Client credentials
. . .
# Integration assistant WorkZone AU Demo 0 certificate, 1 secrat
Application (client) ID Redirect URIs
Manage Se55ed86-e756-4c06-06a3- 1caef240ades 1 web, 20 spa, 2 public client
B Branding & properties Object ID Application ID URI
edbBf7df-fabb-47e7-acb9-4cb365e89437 https//necay testworkzone cloyd
2 Authentication _ o _
Directory (tenant) ID Managed application in local directory
Certificates & secrats 97d075f1-T6a1-4bff-a050-7e7 144193095 Work7one AU Dema

Supported account types

11! Token configuration -
My organization only

= AP| permissions

Example: SnapLogic settings for a WorkZone OData account

Edit Account ?®

Settings  Info
Labal*

Client ID*
1165a79b-265f-4db1-a758-936b97f6CT4d

Client secret

Accoss token

Access token expiration

Header authenticated
OAuth2 Endpoint®
https:iogin.microsoftonline.com/97d075f1-76a1-4bff-a050-Te7144193095/0auth2/v2.0fauthorize
OAuth2 Token®
hitps:Hlogin.microsoftonline.com/97d075f1-76al1-4bff-a050-7e71 44193095 /0auth2/v2.0/token

Grant Type
client_credentials —
KayStora
=] E=
TrustStore
-
= | -

Kay/Trust store password

Koy alias

Token endpoint config + -
Token endpoint parameter Token endpoint paramater value

scope https:inecau.test. workzone cloud/ default -

Auth endpoint config =

Auto-refresh token
| Authorize

| Refrash
Send Client Data as Basic Auth header
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Access control using Microsoft Entra Conditional Access

In WorkZone, it is your organization's security policies that control the access. When a user
logsin, the request is sent to your tenant, where Conditional Access policies determine
whether access should be granted. This means that your organization has full control over
which devices, locations, accounts, and log in methods (for example, multifactor authen-
tication) are allowed.

To ensure effective and secure access management, we recommend utilizing your organ-
ization's existing Conditional Access policies to define specific rules for who can log in and
how. For example, you can restrict access to only approved devices, preventing employees
from inadvertently logging in from personal devices or external networks. This approach is
also used in other systems, such as Office 365.

We do not recommend a whitelist- based solution for access management due to its com-
plexity and ongoing maintenance requirements for both your organization and KMD. A
whitelist- based solution presents several challenges:

* Mobile devices: To secure mobile access, it requires routing through the organ-
ization’s network, which can slow down the experience and require setup of
mobile VPN solutions.

e Guest access and external consultants: External users, such as KMD consultants,
will not be able to access the system outside your network, which can complicate
remote support and setup.

* Third- party integrations: Integrating with external systems require accessto your
network or continuous whitelisting, which can lead to administrative challenges.

Instead of whitelisting, we recommend using Conditional Access to achieve the desired
security control in a flexible and maintenance- friendly manner.

We also advise against using geographic IP filtering as a security measure. Hackers often
use VPN solutionsto hide their true location. VPNs can bypass geo- blocking on streaming
services and mask a user’s actual location providing a false sense of security and creating
access issues for legitimate users working from abroad or via changing networks.

We support using the organization’s existing security setup, but we are not specialistsin
setting up Conditional Access policies. Therefore, we recommend involving your IT man-
agers or security advisors to ensure that access policies fulfill your needs and security
requirements.
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Read about Microsoft Conditional Access in Microsoft Entra Conditional Access doc-
umentation.
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Replicate WorkZone users and access codes from a local AD

If you use WorkZone version 2024.10or newer versions, you must use Entra ID to authen-
ticate your WorkZone users. If your organization has a local Active Directory, it is possible
to replicate the users, access codes, and organizational units that you have in that local AD
to WorkZone.

This setup is relevant for organizations who upgrade from an on- premises version of
WorkZone where the Authentication was locally stored, or for organizations that have a
need to create and maintain complex access structures from alocal AD.

Prerequisite: Before you can get started with replicating users, access codes, and
OU'sto Entra ID, you must first:

* Create and configure the relevant AD groups and have a valid ADreplicator
config file. See Pre- configure with the wizard.

* If you have user provisioning set up using SCIM, you need to disable it.

See Access Active Directory and the rest of the AD guide for more information.

To get started, you must:

1. Install the WorkZone ADreader service on an internal server and make sure that
it has accessto the local domain. See Install the AD reader.

2. Create an application registration in Entra ID for the WorkZone ADreader ser-
vice to connect to WorkZone and update users. Configure the replication set-
tings.

3. Set the service to run at a schedule to apply on- going changesto the local AD
in the WorkZone database.

Active Directory replication from an on-premises AD

In a situation where the domain controller (and therefore the active directory) is located
on an on- premises machine and WorkZone is installed and runs in an Azure environment,
you must still be able to replicate the active directory structure from the on- premises
domain controller to the WorkZone database in the Azure environment.
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WorkZone Cloud and Active Directory synchronization diagam

WZ App registration

CUSTOMER
DIRECTORY

WorkZone
Cloud

v v
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'

I

SERVICE I
I

I

I

1

|
i Customer OnPrem |ullie

Diagram notes

In this example, an on- premises setup contains the Active Directory servers and data as
well as clients. WorkZone is also installed on the on- premises site in order to run the
WorkZone Active Directory service for synchronization purposes.

The customer setup also includes synchronization with Entra ID as well as utilization of the
Microsoft Office 365 suite in the Azure cloud environment with Entra ID users.

The organizational structure as well as other WorkZone- relevant data from the Active Dir-
ectory is published to the WorkZone public endpoint.

User authentication is performed in the customer’s Entra ID, where an app registration is
used for WorkZone Cloud to authenticate the users.
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The customer has an on- premises setup that contains the Active Directory servers and
data as well as clients. A WorkZone Active Directory is required on the on- premises site in
order to synchronize organizational structure as well as access codes.

Customers connect to the public endpoint. The public endpoint only grants accessto
WorkZone services such as OData, WorkZone Client, and WorkZone Configurator, but does
not grant accessto internal cloud infrastructure such as virtual machines and other " hard-
ware" based cloud services.

Differences between an On- premises and WorkZone Cloud Active Directory
replication

Running this type of replication in a WorkZone Cloud setting closely resembles running an
Active Directory replication in an on- site setting with an on- site domain controller and
network users using windows authentication but there are several important differences
due to the capabilities of the Entra ID and the two different environments.

These differences are:

* You must set up the active directory replication to export the active directory struc-
ture from the on- premises domain controller to the WorkZone database in the
Azure environment. The export also creates an update task in the WorkZone data-
base on the Azure environment.

You can set up the program that exportsthe Active Directory structure as a recur-
ring windows task. This ensures replication of the active directory structure at a
time that fits your organizations’ non- working hours, maintenance schedule, and
back- up timetable.

* A Windows service is installed when WorkZone isinstalled in the Azure envir-
onment.
The service is enabled and automatically started on the WorkZone and will execute
the update task and update the WorkZone database with the active directory struc-
ture that is exported by the active directory reader on the on- premises server that
isconnected to the domain controller.

See also

* Automation of active directory replication
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Upgrade from an on-premises ADReplicator

This topic contains relevant information for users that want to upgrade from using the
sjActiveDirectoryReplication.exe program (AD Replicator) to using the wzAct-
iveDirectoryReader.exe program (AD Reader).

The AD Replicator is an on- premises service that reads data from your Active Directory
and applies it to WorkZone via a direct ODBC database connection. The wzAct-
iveDirectoryReader.exe file isinstalled on an on- premises server that is connected to the
Domain Controller. Once installed correctly, the AD Reader reads data from your Domain
and stores it via OData in JSON format on your WorkZone database.

Note: The AD Reader has the same user interface as the old AD Replicator.

The Active Directory Writer service

The Active Directory Writer is a container service that isinstalled with the rest of the
WorkZone Cloud containers. It transforms domain data that is saved by the AD Reader and
appliesit to WorkZone. Beginning from WorkZone 2025.0, AD Reader is no longer con-
figurable via WorkZone Configurator. See Install the AD reader and Configure the rep-
lication settings

Install the AD reader

The wzActiveDirectoryReader.exe program must be installed on an internal on- premises
server that has accessto the local domain controller machine because it opensthe Active
Directory Connector form which it usesto find, export, and transfer the active directory
structure to the WorkZone machine in the Azure environment.

Prerequisite: Before you install the AD reader, there are some required changes on
both the customer side and in the WorkZone database. It is necessary that you syn-
chronize your work with the WorkZone technician who manages your upgrade/in-
stallation. See the required tasks below.
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Before you upgrade the AdReader/WorkZone

Important: When upgrading from WorkZone 2024.5 or older to WorkZone 2025.0 or
newer versions, you must create an app registration in your Entra ID tenant before
the WorkZone upgrade, and send the Enterprise Application Object ID to KMD. See
Configure the replication settings.

1. The KMD technician must add the Object ID that you send to them to the
WorkZone database before you can continue.

update users set oid='<Enterprise Application Object ID>'
where user name = 'SJADREPLICATORUSER';

commit;

2. You can now your make your changesto the wzActiveDirectoryReader rep-
licator config file. If you use a Client Secret, please note that the Client Secret
encryption must be done on the new AD Reader and not in the old AD Con-
nector.

Install the wzActiveDirectoryReader.exe program on an internal server

1 Onthe machine where WorkZone isinstalled, locate the wzAct-
iveDirectoryReaderSetup.msi installer. The default path to the programisc: >
Program Files (x86) KMD > WorkZone > Program > wzAct-
iveDirectoryReader. Thislocation may be different if you have changed the
default installation location of your version of WorkZone.

2. Copy and paste the wzActiveDirectoryReaderSetup.msi installer to the on- site
domain controller machine that contains the active directory for the on- site
users that you want to replicate to WorkZone.

3. Run the wzActiveDirectoryReaderSetup.msi installer.

4. When theinstallation is finished, the wzActiveDirectoryReader.exe program will
be located inthe C: > Program Files (x86) KMD > WorkZone > Program

> wzActiveDirectoryReader folder.
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See also

Configure the replication settings

WorkZone Active Directory Connector

To make Active Directory comply with WorkZone once the data is transferred, you must
perform initial configuration using the WorkZone Active Directory Connector.

You can access the application from the default path at (x86)\KMD\WorkZone\Pro-
gram\wzActiveDirectoryReader. Run the wzActiveDirectoryReader.exe application as
administrator.

WorkZone Active Directory Connector facilitates the transfer (replication) of data from Act-
ive Directory to WorkZone. The administration of users, user security codes, access codes,
units, and committees are maintained in AD but this data must continually be updated

and transferred to the WorkZone database.

In order for WorkZone to correctly receive the transferred data, it is essential that the Act-
ive Directory configuration and the WorkZone configurations are aligned.

The tasks of transformation of data and alignment are handled by the WorkZone Active
Directory Connector.

Configure the replication settings

Defining the replication settings in the WorkZoneActive Directory Connector form for an
Entra ID authentication isidentical to defining the replication settings, for example, for an
on- site client- server environment, but you must also define the Entra ID app registration
for the Entra ID authentication in WorkZone. User authentication is performed in Entra ID
where an app registration is used for WorkZone Cloud to authenticate the users.

Important: The AD Connector only works with Entra ID. That means that the AD Con-
nector must be created as a separate application in the Entratenant. There is a ded-
icated script for that. It registers Entra application called kmd- workzone- ad- reader.
In multi- tenant architecture where WorkZone is hosted on another server than your
tenant application, the kmd- workzone- ad- reader must be registered as an applic-
ation in your Entra ID tenant.
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Register the app with the script
To register the application in your Entratenant, you can run the designated script that is
delivered with the wzActiveDirectoryReader installer.
Run the script with the following parameter:
\AdReaderConfigure.psl -TenantId [guid]

When you have run the script, it should provide the following output. It isimportant that
you copy and paste thisinformation locally as you will need it later.

ClientPortalUrl: https://portal.azure.com/
#view/Microsoft AAD RegisteredApps/Application
MenuBlade/~/Overview/appId/[Guid: Application Client ID]
Client ID: [Guid: Application Client ID]

Client Secret: [Application Client Secret]

Enterprise Application Object ID: [Guid: Application Service Prin-
cipal]

Register the app manually on the Azure Portal

The first stepsin the app registration process is similar to third- party app registration. See
Set up third- party integrations in Azure.

1 In your Entratenant, go to App registrations and create a new app registration.

2. Fillin the name of the app (The recommended name is kmd-workzone-ad-
reader), and click Register.

3. Go to Certificates & secrets, add a client secret or a certificate, and then click
Create.

Important: Immediately after clicking Create, copy the client secret and
paste it to, for example Notepad, as you will need it later. Thisisthe only
time that the client secret is shown. If you do not copy it right away, you
have to create a new client secret.
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4. Go to Enterprise applications > All applicationsto see the object ID (Enterprise
Application Object ID) for the app registration.

Configure active directory replication for an Azure environment

You can either create a new active directory connector configuration with the wizard and
then configure the file manually, or edit an existing configuration directly.

1 Onthe on-site server, run the wzActiveDirectoryReader.exe program with
administrator privileges to open the WorkZoneActive Directory Connector
form.

2. Inthe WorkZoneActive Directory Connector form, click Edit to open the
WorkZone Active Directory Connector Configuration form.

3. Inthe WorkZone Active Directory Connector Configuration form > Client Secret
field, enter the Entra ID authentication client secret that you have saved during
one of the previous steps.

4. Set up all other active directory connector configuration settings as you nor-
mally would for replicating the active directory in a solely on- site environment
and click Save to save your changes.

The Entra ID authentication client secret or certificate for active directory
replication

To connect to the WorkZone database in the Azure environment, you must specify the
Entra ID authentication client secret in the WorkZone Active Directory Connector Con-
figuration form or the certificate path in the configuration file. If the Entra ID authen-
tication client secret isincorrect or omitted, the Active Directory replication will fail.

See also:

¢ |nstall the AD reader
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User account permissions

User account

It isimportant that the user account that is used to run the Active Directory Connector has
the necessary permissionsto run the Active Directory Connector before you start the con-
figuration.

User permissions

User permissions are essential in two aspects:

* The permissionsthat a user needsto run the wizard in Active Directory Connector.

* The permissionsthat a user needsto run the scheduled task transfer of data from
Active Directory to WorkZone.

Permissions to initiate the wizard

The first time you run WorkZone Active Directory Connector (wzAct-
iveDirectoryReader.exe), the WorkZone Connector Setup wizard is initiated. It guides
you through the alignment between Active Directory and WorkZone. You only have to
establish this alignment once. It isimportant that you have write access, for example as
an Administrator, to the WorkZone Connector Setup wizard's installation folder because
the config file needs to be saved there.

Note: If you want to represent Organizational unitsin WorkZone as Active Directory
groups instead of Active Directory organizational units, you must start the Active Dir-
ectory connecter with the useGroupAsOU option, see also Command line parameters.

The wizard writes directly to AD and it is therefore essential that the user account has the
necessary permissions to create the following objects in AD:

* Organizational unit with the ScanJourCaptiaAdministration titlein the root of
Active Directory.

e 1luniversal distribution groupsin the subtree of ScanJourCap-
tiaAdministration Organizational unit
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° ScanJourCaptia<database name><i>|=1-9 - used to align users' secur-
ity levels. Each distribution group represents equal security groups in
WorkZone.

° ScanJourCaptia<database name>Groups - used to identify the access
codes.

°© ScanJourCaptia<database name>Committees - used to identify com-
mittees.

° ScanJourCaptia<database name>O0Us - used to identify the root Organ-
izational units. It isonly added if the option useGroupAsOU is used.

Note: <database name> must be substituted with the current ODBC database name.

To create these 11 groups, click Create in the Active Directory Connector wizard. See Pre-
configure with the wizard.

Permissions to run a scheduled transfer task

To run a scheduled task of transferring data from Active Directory to WorkZone, you must
use a user account with rightsto;

* View the relevant Organizational unit's, groups, and users in Active Directory.
* Write entriesin the event log.

* Create and update in the following sub key entries in the Windows Registry:

HKLM\ SOFTWARE\ SCANJOUR\SJAD class-
="code">HKLM\ SYSTEM\Cu-

rrentControlSet\Services\Eventlog\Application

Pre-configure with the wizard
The wizard guides you through the following steps during the pre- configuration of Active

Directory Connector:

* Specification of the database name.
* Specification of the domain server name.

* [|nitiation of the needed distribution groups in WorkZone dedicated AD.

146



KMD

WorkZone WorkZone Cloud Edition 2025.0 Installation and Operations Guide

e Initiation of the creation of the configuration file that secures the alignment
between AD and WorkZone.

* Creation of a desktop shortcut to Active Directory Connector for easy maintenance
access.

* Configuration of a scheduled task which periodically automatically secures align-
ment of data.

Preconfiguration wizard

1 Inthe WorkZone program folder C:\Program Files
(x86) \KMD\WorkZone\Program\wzActiveDirectoryReader, double- click
the \wzActiveDirectoryReader.exe file to start the Active Directory Con-
nector Wizard.

2. Click Next.

3. Onthe Database tab, enter aname. The field isonly used to generate the con-
figuration file name and Administrative Group prefixes and is not used for con-
nection purposes.
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4. Click Next.

= Welcome to the WorkZone Active Directory Connector 5et.. — O ot

Setup of transfer from Active Directory to WorkZone

Introduction Database Domain  Administrative groups  Setup

Which \WaorkZone database is the target of the transfer?

Database db01

Previous Mext Exit

5. On the Domain tab, click Current Domain to insert the name of the current
domain, or enter the name of your server domain in the Domain field. Click
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Next.
= Welcome to the WorkZone Active Directory Connector Set.. . — O >

Setup of transfer from Active Directory to WorkZone

Introduction Database Domain  Administrative groups  Setup

Which Active Directory domain is the source of the transfer?

Domain Imdom lacal/DC=mdom . DC=local Current Domain

Previous Mext Exit

6. Onthe Administrative groupstab, in the Group prefix field, the wizard suggests
a prefix for the 11 distribution groups that it is about to setup for the transfer
of security codes, committees and group access codes — ScanJourCap-

tia<database name>.

To enhance legibility, it isrecommended that you add a separating character
such as a dash after the <database name>.
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o= Welcome to the WorkZone Active Directory Connector Set.. — O x

Setup of transfer from Active Directory to WorkZone

Introduction Database Domain  Administrative groups  Setup

|Users, groups and committees are chosen for transfer by being members in certain
groups. This wizard can help creating a standard setup of these groups.

Group prefix WarkZone_db01_

The administrative groups will be named WorkZone_db01_1. ... WorkZone_db01_5,
‘workZone_db01_Groups and WorkiZone_db01_Committees.

Creation of administrative groups

The program can create these administrative groups in Active Directory, so that users,
groups and committees can be transferred by adding them as members. Alternatively,
the groups can be created manually or existing groups can be reused.

Create

Previous Mext Exit

7. Click Create.

8. Inthe Creating groupsin AD dialog box, click OK. The groups are created in the
ScanJourCaptiaAdministration entry in the AD. You can rename the entry.

9. Click Next.

10. On the Setup tab, in the Run in interactive mode section, click Run now to cre-
ate the configuration file.
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= Welcome to the WorkZone Active Directory Connector Set...  — O X

Setup of transfer from Active Directory to WorkZone

Introduction

Database Domain  Administrative groups  Setup

Run in interactive mode

The configuration can be tested by running the transfer in interactive mode. It might be
useful with a shortcut on the desktop for this.

Run now Create shortcut

Setup scheduled task for transfer

It is recommended to create a scheduled task for daily transfer when the setup
has been finished.

Create job
Advanced options
Setup of multiple domains, change of administrative groups, choice of
organizational units, etc.
Cipen
Previous BExat

The file is called STADConfiguration<database name>.xml and can be
found in the KMD program folder. It isused in the alignment of transferred
data from AD to WorkZone.

The sJADConfiguration<database name>.xml file isshown.
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= WorkZone Active Directory Connector = O >

Ifo: SJADWindow SJADWindow_Load(): Canfiguration fram file: Wark Zone_db01_SJADCorfiguration xmi
Info: SJADWindow SJADWindow_Load(): log to file:

WordZone_db01_SJADConfiguration xml Configuration Edit...
[] total update Transfer Save output Exit
database;

11. Click Edit. The Active Directory Connector configuration window appears.

= Active Directory Connector configuration = O bt
Configuration file
File name WorkZone_db01_5JADCorfiguration xml
Open...
pen Mew Save as.. Save
Client Secret

Organizational unit AD field to use as identifier:

Domain servers

Imdom local /DC=mdom DC=local Add.. Show
Edit...
Delete Eat

12. Inthe Client Secret field, paste your client secret. It isimportant that the client
secret isunencrypted because the AD Reader will not be able to processthe
secret if it isencrypted. The secret will be encrypted once you click Save in the
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next step.

13. In the Configuration file section, click Save. The configuration file is now saved
with an encrypted client secret and your entriesin the KMD program folder.

14. Click Exit.

15. Inthe Run in interactive mode section of the WorkZone Active Directory Con-
nector wizard, click Create shortcut.

A desktop shortcut icon linking to the Active Directory Connector for easy
access is placed on your desktop with the title wzad<database name>, for
example, wzadfortest. When you click the shortcut, the Active Directory Con-
nector will open on the screen that is shown in the second screen shot in step
10.

Connect Entra to a local AD

Update configuration file

The AdReader configuration file must be completed with the following items. Note that Cli-
ent Secret or Certificate can be provided to authenticate.

<configuration>

<azureTenantId>tenant where application is located, same as set in

WorkZone OData endpoint configuration]</azureTenantId>
<azureClientId>[Application Client ID]</azureClientId>

<azureClientSecret>[Client Secret (plain text or encoded)]</azureCli-

entCertificatePath>

<azureClientCertificatePath>[Instead of Client Secret certificate

can be provided]</azureClientCertificatePath>
<oDataUrl>[Url to WorkZone ODatav3 service]</oDataUrl>
</configuration>

Additionally, dedicated WorkZone users must be updated in the WorkZone database.

update users set:
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update users set oid='<Enterprise Application Object ID>' where

user name = 'SJADREPLICATORUSER';

commit;

Note: The column Ntauthentication in the users table must be set to 'J for
'SIADREPLICATORUSER'.

Create a scheduled task transfer

1 Start WorkZone Active Directory Connector.

2. Inthe SJActive Directory Connector window, click Run Wizard.
3. Inthe wizard, click the Setup tab.
4

In the Setup scheduled task for transfer section, click Create job. The task is
now available via Windows Task Scheduler.

5. In Windows Task Scheduler, click Task Scheduler Library to view the task. The
task isnamed wzADreplication <database name>.

6. To set thetask up to run at a specific time, right- click on the task and select
Properties. On the Triggers tab, click Edit to open the Edit Trigger window and
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set up when the task should be performed and at which interval.

Edit Trigger -

Begin the task: |Gn a schedule v|
Settings

) One fime Start: | gr21/204 [E- || o000 | [ ] Synchronize across time zones

® Daily
|1
) Weekly Recur every: days

() Monthly

Advanced settings

[ ] Delay task for up to (random delay): |1 hour
[ ] Repeat task every: |1 hour 1 day

[] Stop task if it runs lenger than: 3 days

[ Expires | 8/21/2015 [E 126:30 PM

W

Enabled

QK | | Cancel

Note: It isrecommended that you disable the task until you have finished your AD
configuration. To do this, clear the Enabled check box in the Edit Trigger dialog box.

Log on options

When the Active Directory Connector wizard is used to create a scheduled task for the rep-
lication, the job is created with the Run only when user islogged on option.

If you want to change thisto Run whether user islogged on or not, you must also select
the Run with highest privileges option.
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(L) sjADreplication_db01 Properties (Local Computer) -

General | Triggers | Actions | Conditicns I Settings | History |

Mame: | siiDreplication_db01 |
Location: !

Author administrator

Description:

Security options

When running the task, use the following user account:

LMDOM\adrninistrator Change User or Group...

() Run only when user is logged on
® Run whether user is logged on or not

[] Do not store password. The task will only have access to local computer resources.

Run with highest privileges

[] Hidden Configure for: | Windows Vista™, Windows Server™ 2008 'V|

QK | | Cancel |

Command line parameters

Command line parameters are used while running the scheduled task, see Create a sched-
uled task transfer and its default setting from the initial setup may be changed.

To change the setup, open the Scheduled Task window and select the Task tab. In the Run
field, you can see the default command line parameters.

In the table below is an overview of command line parameters, their default values and

comments:
Parameter Default value Comment
/db=<database name> No default value. Definesthe WorkZone database.

This field cannot be empty, but
the value is not used for con-
nection.
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Parameter Default value

/window /nowindow If the database is specified,

or /wizard /window is the default. If the
database is not specified,
/wizardisthe default.

Comment

Defines whether the program
should show GUI and whether it
should be the transfer status win-
dow (\window) or the wizard
(\wizard).

/forceupdate No default value.

Configuration file changes since
last transfer will be checked.

Displays all data (user, user
information, and so on) that
needsto be updated. If it is not
specified, the modified date in
Active Directory is compared
with the last transfer.

/config=<file name> SJADCon-
figuration<database

name>.xml

Defines the location of the con-
figuration file.

/set- No default value.
sid=<SystemUser>

This user must be present in Act-
ive Directory, but should not be
included as a member of any of
the administrative groups or
access code groups.

As aresult, the system user is
looked up in the domain where
the SID isread and is written
into the database, so that the
user can log on to WorkZone.

Normal replication is not per-
formed - only this single user is
handled.

/useGroupAsOU No default value.

When used, the wizard uses the
template SJADConfiguration-
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Parameter Default value

Comment

templateOU.xml instead of the
template SJADConfiguration-
template.xml, and this way
forces use of AD groupsto rep-
resent OUs instead of AD organ-
izational units.

/readcheck No default value

If this parameter is applied, a
check is carried out and only if
no errors are found, the rep-
lication is performed.

/logfile sjad replication.log

The log file will be located in the
folder where Active Directory
Connector isrun from.

You can use the option /1log-
file when the option /now-
indow isused. The information
that is displayed on the screen
when clicking Transfer, islogged
to afile, either to the default file
or to a specific file, for example
/log-
file=c:\ADlogs\ADrep.log.

/Showrenaming No default value.

If this parameter is applied, the
following check boxes will be dis-
played in the Active Directory
Connector configuration form:

e Allow renaming of users

e Allow renaming of org.
units

e Allow renaming of
groups

158



KMD

WorkZone WorkZone Cloud Edition 2025.0 Installation and Operations Guide

Parameter Default value Comment

e Allow renaming of com-
mittees

e Allow new instances
users

The settings determine if users,
organizational units, group and
committees can e renamed in
the Active Directory.

Best practices and recommendations

Below you will find recommendations, best practices, and general advice concerning
WorkZone Active Directory Connector and pre- transfer issues.

Monitor first transfer in the Event Log

It isrecommended that you monitor your first transfer of user data from Active Directory
to WorkZone with WorkZone Active Directory Connector The trial transfer is described in
Transfer data.

All errors are reported in the Windows event log. You should monitor the event log care-
fully through the initial transfer. Fix the errors that occur while monitoring the event log.
You can check the event log in Event Viewer.

* To open Event Viewer, click Start > Control panel > Administration tools > Event
Viewer.

You must run atotal update enabled transfer. To do this, in the WorkZone Active Directory
Connector form, select the total update check box before you start a transfer.

One Configuration File per Database

* You must have only one configuration file per database. Make sure that your
scheduled tasks use the correct configuration file.

* If you transfer manually, always disable the scheduled task.

* Perform only one transfer per database at any time.
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* If you are doing major maintenance in AD, stop your scheduled task while you are
manually monitoring you transfer.

* Enable the scheduled task when the procedure is completed, see Re- enable the
scheduled transfer task.

Do not Change the name codes

If you need to change user names, unit names, or pre- Windows 2000 group names, do not
make these changes in Active Directory without analyzing and mapping the consequences.
If you do, the transfer will report the changes as errors.

If you need to change, for example, the initials of a user, it isrecommended that you
delete this user and create a new one. After this, you will have to change the deactivated
user to an active user on cases, objects protected with a user access code, personal and
general drafts that has not been archived yet, ownerships of reminders, personal pref-
erences in the user interface, and so on. You have to transfer, or mass edit, or move the
ownership to the new user.

You should also configure the new user asthe old user, see Apply security groups to users.

Domain Server Connection

For each domain server you must enter the name of the server (or its IP address). If the
program is not running as a trusted user of the domain, you have to specify the user name
and password of a user that has permissionsto read in AD's file catalog. The domain name
may also be entered as a LDAP distinguished name as: DC=scanjour, DC=dk.

The WorkZone Active Directory Connector supports specification of logon information to
be used for reading from the domain. Thisinformation is stored in the XML configuration
filein the form of a user name and a password in encrypted form.

As in earlier versions, it is still possible to avoid specifying any logon information in the
WorkZone Active Directory Connector itself. Instead, it can be run under an account with
the needed permissionsto read from the domain.

The password is encrypted in such a way that it can only be decrypted on the same
machine as the one that was used during encryption. Encryption happens when you click
OK in the Domain Server dialog box where the logon information has been specified.

This meansthat if you move the XML configuration file to another server because you
want to use it with WorkZone Active Directory Connector, you need to re- enter the pass-
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word of the logon information in the Domain Server dialog box after having moved the
XML configuration file to the new server.

Users

The Groups identifying ScanJour WorkZone users list in the Domain server window in
WorkZone Active Directory Connector lists the global distribution groups that identify
users to be transferred.

If auser isa member of more than one group, he/she isautomatically assigned the
highest security code.

OUs and Units

The Units list in the Domain server window in Active Directory Connector displaysthe
Organizational units that identify the Organizational unit to transfer into unitsin
WorkZone.

If the Recursive check box is selected for an Organizational unit, all underlying Organ-
izational units will be transferred as well, see Register Organizational unitsin
WorkZone Active Directory Connector, step 5.

The Scheduled Task Transfer

When your transfer runs without any errors (and the event log also has no errors) you
must configure a scheduled transfer task at a regular interval between 2 hours and once a
day, depending on the size of your organization.

You can set up a scheduled task from the wizard, see Create a scheduled task transfer

If you change your scheduled task or make changesto the configuration file, make sure
that the configuration isreflected in the command line parameters, see Monitor the trans-
fer.

Mapping the AD Fields to WorkZone Fields

The configuration file contains the information regarding which AD field is transferred to
which WorkZone database field. Thisinformation can be maintained directly in the XML
configuration file.

Note: You must make changes manually in the XML- file using a text editor.

161


../../../../../Content/WZCloud_Install_Ops_Guide/Install/CS_AD/OUs_in_AD/Register_OUs_SJ_AD_Connector.htm
../../../../../Content/WZCloud_Install_Ops_Guide/Install/CS_AD/OUs_in_AD/Register_OUs_SJ_AD_Connector.htm
../../../../../Content/WZCloud_Install_Ops_Guide/Install/CS_AD/Monitor_Transfer.htm
../../../../../Content/WZCloud_Install_Ops_Guide/Install/CS_AD/Monitor_Transfer.htm

KMD

WorkZone WorkZone Cloud Edition 2025.0 Installation and Operations Guide

The XML file contains a number of <userField>, <UnitField>, and <CommitteeField>
with specifications of what is transferred from where to where.

Changes can be made but consult your software provider and your KMD technician, see
Feld to field transfer between Active Directory and WorkZone and ADSI field names.

Troubleshooting

The WorkZone Active Directory Connector window prints all log on its screen. All issues are
printed in red color (see the screenshot below for an example). Some error messages con-
tain detailed information. To make the error message more readable, you can copy the
error message and paste it in your preferred text editor.

= WorkZore Active Directory Comnector - =] b4
Infia; SJADWinders SJIADWindow_Load(): Configuration from file: C: sl
Infa: SJADWindo SJADWIndow_Load(): log b file 20050802 _142111- 25852 log

Infa: SJADWinderw AdWite(l: Uset NT suthentication
Irfo: SUADWindow AdVWite: Save data to database start
ERROR: SJADWedow Binlsers_ Click(): Excaplicn mmeng Active Dimclony mplication: An emor occarmed while processing his mouss!
al System.Data. Services, Client, SaveResult Handle PResponse()  of System Data Services Chend . BaseSavePesull EndPequest() of System. Data, Sery
ERROR: SJADWndow binUsers (lick(): Exceplicn detals: Linaulhorized

e Condgurntion Edit
() hotal update Temnsher Desplary coly Flu vzt Save ot =]

database: whatever

Common configuration errors

Below you can see a list of common errors that may occur during configuration, and how
you can solve them.

AADSTS7000215: Invalid client secret provided. Ensure the secret being
sent in the request isthe client secret value, not the client secret ID, for a
secret added to app '<ClientID>'

If you get this message, check that the specified client secret is correct and that it has not
expired.
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AADSTS7000229: The client application <ClientID> is missing service prin-
cipal in the tenant <Tenantld>. See instructions here: https://go.-
microsoft.com/fwlink/?linkid=2225119

Make sure that the ClientID and Client Secret that you have specified are registered in the
tenant with the specified ID <Tenantld>.

Exception running Active Directory replication: Unauthorized
This error occurs because OData can't authorize the access token from from Entra. The
reason may be that the tenant that provided the token is not known by WorkZone OData.

To fix thisissue, make sure that the app isregistered in the correct tenant. It should be
the same tenant that runs WorkZone OData authorization.

Exception running Active Directory replication: Forbidden
This error occurs because the Service Principal (Enterprise Application) Object ID is not set
in the SIADREPLICATORUSER oid column.

To fix thisissue, run the following command on the WorkZone database:

update users set oid='<Enterprise Application Object Id>' where

user name = 'SJADREPLICATORUSER';

commit;
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Terms and conditions

Intellectual property rights

Thisdocument isthe property of KMD. The data contained herein, in whole or in part, may
not be duplicated, used or disclosed outside the recipient for any purpose other than to
conduct business and technical evaluation provided that thisis approved by KMD accord-
ing to the agreement between KMD and the recipient. This restriction does not limit the
recipient’s right to use information contained in the data if it is obtained from another
source without restriction set out in the agreement between KMD and the recipient or by
law.

Disclaimer

Thisdocument isintended for informational purposes only. Any information herein is
believed to be reliable. However, KMD assumes no responsibility for the accuracy of the
information. KMD reserves the right to change the document and the products described
without notice. KMD and the authors disclaim any and all liabilities.

Copyright © KMD A/S2025. All rights reserved.
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